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Preface

Manual Information

Purpose

This manual provides information on the features and applications for the Harris

multiviewer.

Audience

This manual is written for engineers, technicians, and operators responsible for
installation, setup, maintenance, and/or operation of the product, and is useful to
operations personnel for purposes of daily operation and reference.

Revision History

Table P-1. Revision History of Manual

Edition Date Comments

A February 2008 Initial release

B January 2009 Coincides with software release 3.4
C March 2009 Coincides with software release 3.5
D July 2009 Coincides with software release 3.6
E December 2009 Coincides with software release 3.7

Harris Multiviewer Installation, Configuration, and Operation Manual
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Writing Conventions

To enhance your understanding, the authors of this manual have adhered to the
following text conventions:

Table P-2. Writing Conventions

Term or A

Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons,
check boxes, list boxes, combo boxes, menus, submenus,
windows, lists, and selection names

Italics Indicates email addresses, the names of books or
publications, and the first instances of new terms and
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as ENTER,
TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a
DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy
of menus and windows

hyperlink Indicates a jump to another location within the electronic
document or elsewhere

Internet address Indicates a jump to a website or URL

"] Indicates important information that helps to avoid and

£ Note troubleshoot problems

Obtaining Documents

Technical documents can be viewed or downloaded from our website.
Alternatively, contact your Customer Service representative to request a
document.

viii Harris Multiviewer Installation, Configuration, and Operation Manual
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Unpacking/Shipping Information

Unpacking a Product

All products have been carefully inspected, tested, and calibrated before
shipment to ensure years of stable and trouble-free service.

1.

SAREE I A

Check the equipment for any visible damage that may have occurred during
transit.

Confirm that you have received all items listed on the packing list.
Contact your dealer if any item on the packing list is missing.
Contact the carrier if any item is damaged.

Remove all packaging material from the product and its associated
components before you install the unit.

Returning a Product

In the unlikely event that a product fails to operate properly, please contact our
Customer Service Department to obtain a Return Authorization (RA) number,
then send the unit back for servicing.

Keep at least one set of original packaging in the event that a product needs to
be returned for service. If the original package is not available, you can supply
your own packaging as long as it meets the following criteria:

» The packaging must be able to withstand the product’s weight.
e The product must be held rigid within the packaging.

e There must be at least 2 in. (5 cm) of space between the product and the
container.

» The corners of the product must be protected.

If the product is still within the warranty period, we will return it to you by
prepaid ground shipment after servicing.

Harris Multiviewer Installation, Configuration, and Operation Manual iX
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Standards

There are three sets of standards used in the development of the Harris
Multiviewer product line: product standards, compliance standards, and safety
standards.

Product Standards

Professional Video

The following product standards apply to the Harris Multiviewer output
module. Please reference the pertinent standard for more information.

SMPTE 259M

SMPTE Standard for Television - 10-Bit 4:2:2 Component and 4fsc Composite
Digital Signals - Serial Digital Interface

SMPTE 292M

SMPTE Standard for Television - Bit-Serial Digital Interface for High
Definition Television Systems

SMPTE-170M

For Analog Video Signal quality

FCC 73.699

U.S. Federal guidelines for NTSC analog composite video

ITU-R.BT 470

Guidelines for PAL analog composite video

ITU-R BT601-4

For Serial Digital Video

SMPTE 296M

SMPTE Standard for Television - 1280x720 Progress Image Sample Structure -
Analog and Digital Representation and Analog Interface

SMPTE 274M

SMPTE Standard for Television - 1920x1080 Image Sample Structure, Digital
Representation and Digital Timing Reference Sequences for Multiple Picture
Rates.

SMPTE 424M

SMPTE Standard for Television - 3 Gb/s Signal/Data Serial Interface

DVI 1.0

Digital Visual Interface 1.0, Digital Display Working Group (DDWG)
(www.ddwg.org).

SMPTE 12M
SMPTE Standard for Television - Audio and Film - Time and Control Code

Harris Multiviewer Installation, Configuration, and Operation Manual
Copyright © 2008-2009, Harris Corporation



Preface

Digital Audio

PT-PS Power Supply

Other Interfaces

AES3-2003

AES Recommended Practice for Digital Audio Engineering - Serial
Transmission Format for Two-Channel Linearly Represented Digital Audio
Data

AES3id-2001

AES Information Document for Digital Audio Engineering -Transmission of
AES3 Formatted Data by Unbalanced Coaxial Cable

SMPTE 276M-1995

SMPTE Standard for Television - Transmission of AES-EBU Digital Audio
Signals Over Coaxial Cable

Safety

TUV approved to latest revision of UL 60950-1 and CSA 22.2 complete with
CB Report with all country deviations?

CE Mark

EMC Compliance tested under EN 55103-1, 2 as a Class A Device in an E4
environment

IEEE 802.1 (Ethernet)
CSMA/CD Access Method

USB 2.0

Universal Serial Bus 2.0 (www.usb.org)

RS-232 (TIA-232-F)

Interface Between Data Terminal Equipment and Data Circuit-Terminating
Equipment Employing Serial Binary Data Interchange

ANSI/TIA/EIA-422-B
TIA-422 Electrical Characteristics of Balanced Voltage Differential Interface
Circuits

Compliance Standards

EMC Compliance Standards

The following EMC compliance standards apply:

 ENS50081-1
 ENS55022
« EN50082-1

« 1EC 1000-4-2 1995-01

1. A total of 8 PT-PS power supplies can be used in the Platinum frame. TUV will test
for frame leakage currents using all 8 power supplies operating simultaneously to deter-
mine the total frame leakage current. This total frame leakage current value must meet
EN60950 and CSA 22.2.

Harris Multiviewer Installation,
Copyright © 2008-2009, Harris Corporation
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+ |EC 801-3 1984

* |EC 1000-4-4 1995-01

» Part 15 of the FCC Rules

» ICES-003 of the Canadian Department of Communications

Restriction on Hazardous Substances (RoHS) Compliance

Directive 2002/95/EC—commonly known as the European Union (EU)
Restriction on Hazardous Substances (RoHS)—sets limits on the use of certain
substances found in electrical and electronic equipment. The intent of this
legislation is to reduce the amount of hazardous chemicals that may leach out of
landfill sites or otherwise contaminate the environment during end-of-life
recycling. The Directive, which took effect on July 1, 2006, refers to the
following hazardous substances:

* Lead (Pb)

e Mercury (HQ)

e Cadmium (Cd)

e Hexavalent Chromium (Cr-V1)

» Polybrominated Biphenyls (PBB)

» Polybrominated Diphenyl Ethers (PBDE)

In accordance with this EU Directive, all products sold in the European Union
will be fully RoHS-compliant and “lead-free.” (See our website for more
information.) Spare parts supplied for the repair and upgrade of equipment sold
before July 1, 2006 are exempt from the legislation. Equipment that complies
with the EU directive will be marked with a RoHS-compliant emblem, as shown
in Figure P-1.

RoHS
Compliant

Figure P-1. RoHS Compliance Emblem

Waste from Electrical and Electronic Equipment (WEEE) Compliance

The European Union (EU) Directive 2002/96/EC on Waste from Electrical and
Electronic Equipment (WEEE) deals with the collection, treatment, recovery,
and recycling of electrical and electronic waste products. The objective of the
WEEE Directive is to assign the responsibility for the disposal of associated
hazardous waste to either the producers or users of these products. Effective
August 13, 2005, producers or users will be required to recycle electrical and
electronic equipment at end of its useful life, and may not dispose of the
equipment in landfills or by using other unapproved methods. (Some EU
member states may have different deadlines.)

Xii
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In accordance with this EU Directive, companies selling electric or electronic
devices in the EU will affix labels indicating that such products must be
properly recycled. (See our website for more information.) Contact your local
sales representative for information on returning these products for recycling.
Equipment that complies with the EU directive will be marked with a
WEEE-compliant emblem, as shown in Figure P-2.

Figure P-2. WEEE Compliance Emblem

Harris Multiviewer Installation, Configuration, and Operation Manual Xiii
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Safety Standards
The following safety standards apply:
« 1EC-950
» UL 60950-1

* ENG60950: 1992 + A1: 1993 + A2: 1993 +A3: 1995 A4: 1997 +A11:
1997 EMKO-TSE (74-SEC) 207/94

* UL1419
* CSAC22.2No.1

Safety

Carefully review all safety precautions to avoid injury and prevent damage to
this product or any products connected to it. Any user-serviceable components
(such as fuses or batteries) are only replaceable by those components listed in
the manual.

IMPORTANT! Only qualified personnel should perform service procedures.
Safety Terms and Symbols in this Manual
WARNING
A Statements identifying conditions or practices that may

result in personal injury or loss of life. High voltage is
present.

CAUTION
A Statements identifying conditions or practices that can
result in damage to the equipment or other property.

Xiv Harris Multiviewer Installation, Configuration, and Operation Manual
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Chapter 1
Introduction

Installing and

Connecting Overview

Multiviewer output modules are installed in the output section of Platinum
router frames. Each output module occupies four output slots in the router
frame. Since the multiviewer output module is shipped as a complete
“solid-state” unit, you do not need to install individual components.

Warning

Potentially lethal voltages are present within the Platinum frame during
normal operation. Disconnect all power cords from the frame before you
remove the top panel. Do not apply power to the frame while the top is open
unless the unit is being serviced by properly trained personnel.

Multiviewer output modules are hot-swappable, and they do not need to be
installed next to each other. However, keep in mind that the slots you select to
install the multiviewer may affect how efficiently of how you can populate other
output slots in the router.

ACaution

We recommend that you test your system before placing it in its final
installation. Make sure that you verify its configuration, cabling, and proper
system operation. Observe proper anti-static and grounding procedures
while handling loose boards and servicing equipment.

The Harris multiviewer output module occupies four slots in the output section
of a Platinum router. With the multiviewer fully-integrated into your routing
network, it can display any of the Platinum router input sources. These can be
selected from a wide variety of input modules: auto-detecting 1080p/HD/SD
video with embedded audio, analog video, and graphics input as well as discrete
analog or AES audio.

The Harris multiviewer supports all critical display resolutions up to 1900%1200
dpi, and the DVI outputs can be set for any of the supported resolutions. You
can select between two output display modes as well as select either portrait or
landscape orientation so that you best utilize your output display devices. The
Harris multiviewer allows custom resolutions, for example 1080x1100.

Harris Multiviewer Installation, Configuration, and Operation Manual 1
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Chapter 1: Introduction

In addition to the multiviewer’s outputs, connectors are provided for two
Ethernet connections, a linear timecode input, four USB ports, and AES outputs
for audio monitoring.

You can use the Layout Designer software that comes with your multiviewer to
monitor all audio and video signal characteristics through integrated alarms,
audio metering, and other test and measurement tools. With Layout Designer,
you can also select preset layouts and create custom layouts. When connected to
a CCS network, your Harris multiviewer can be controlled by CCS control
applications such as CCS Navigator and NUCLEUS network control panel. For
more information about Layout Designer features, see “Layout Designer” on
page 4.

2 Harris Multiviewer Installation, Configuration, and Operation Manual
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Chapter 1: Introduction

Main Features

Audio and Video/Graphic Inputs

Communication

Up to 512 input video sources

System scalability that allows you to put multiple output modules in a 9RU,
15RU, or 28RU Platinum frame

Auto-detection and support of 3Gbps-SDI, HD-SDI, and SD-SDI including
embedded audio

Using specific Platinum input modules, auto-detection and support of
analog video inputs, discrete analog audio, and discrete AES audio

Support for the following video standards:

«  486i@59.94 fps (SMPTE 125M)

« 576i@50 fps (ITU-R BT.656)

o 720p@59.94 fps (SMPTE 292M, SMPTE 296M)
* 720p@50 fps (SMPTE 292M, SMPTE 296M)

» 1080i@59.94 fps (SMPTE 292M, SMPTE 274)
* 1080i@50 fps (SMPTE 292M, SMPTE 296M)

o 1080psf@23.98 fps

* 1080p@24, 25, and 30 fps

* 3Gbps 1080p@50 and 60 fps

Input for an external linear code signal for on-screen clock time reference
source

Serial connection provides connection to a serial breakout provides two
RS-232 and two ports that can be configured as RS-232, RS-422, or RS-485

Four type A USB ports on the back module and two type A USB ports on
the front module can be used for general purposes such as computer mouse
and keyboard connections (for Heads-Up operations)

Two 10/100/1000 Ethernet ports for communication with Layout Designer,
other CCS-networked devices, JLCooper eBOX, and GPIO devices

Monitoring and Control

Standard multiviewer system audio and video alarms such as signal
presence, freeze detection, black detection, audio overshoot, and silence
detection

On-Screen application to manipulate the multiviewer right on the display,
eliminating the need for an external computer to make adjustments to
layouts

Harris Multiviewer Installation, Configuration, and Operation Manual 3
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Chapter 1: Introduction

Output Display

Layout Designer

»  Waveform monitor and vectorscope capabilities to monitor the video
quality control of one video source at a time, to ensure it complies with the
required standards

» The Rules Editor to program the multiviewer to respond to video, audio,
system or facility alarms. These can range from sending out alarm
notifications into a network by E-mail, to switching layouts on the
multiviewer or switching sources on a Platinum router

* The Triggers Configuration Window for programming the multiviewer to
perform specific tasks at different times.

e Outputs up to 64 HD-SDI displays or up to 32 DVI displays from a single
28RU Platinum frame with up to 16 multiviewer output modules. There are
32 addressable inputs, to a maximum of 64 PiP (picture-in-pictures)
windows per multiviewer, shared across all displays.

»  Provides three user-selectable output modes for DVI and SDI outputs:
* Independent mode—One layout per display (dual or quad display)
e Spanning mode—More than one display per layout
* Redundant mode—two copies of the same layout

* AES audio monitoring using external monitoring devices

Layout Designer is the primary configuration and control application for
multiviewer systems. You can connect a multiviewer to a PC that is running
Layout Designer by using one of the Ethernet connections on the back module.
In addition to multiviewer configuration and control, Layout Designer provides
signal monitoring, alarm feedback, and layout creation and design capabilities.
Layout Designer features include, but are not limited to, the following:

o Standard and customized layout templates, Picture-in-Picture (PiP),
borders, and labels

e On-screen clocks and counters that can be locked to an external timecode
reference source

»  User-definable rules generator and manager

» Standard and custom UMD/Tally indicators

* Audio meters and video signal analysis/monitoring
* On-screen audio and video alarms.

For more information about using Layout Designer with your multiviewer
system, see “About Layout Designer” on page 14 or your Layout Designer
Software Application User Guide.

You can also use the on-screen control application for limited control of your
multiviewer system without external software or other CCS network control
devices. For more information, see “Multiviewer Configuration and Control” on
page 13.

Harris Multiviewer Installation, Configuration, and Operation Manual
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CCS Control with Navigator and NUCLEUS
Using CCS Navigator and NUCLEUS, you can do the following.
» Select layouts that are stored on the multiviewer hardware for display

»  Monitor multiviewers for audio and video signal alarms as well as alarms
for system diagnostics

Applications

Harris multiviewer systems can be used for, but are not limited to, the
monitoring and control of the following broadcast facility environments.

»  Network master control operations

» Satellite uplink stations

» Fixed sporting installations

Non-broadcast applications of Layout Designer include
» Government installations

» Data monitoring facilities

e Security monitoring and surveillance for highways, public transportation
systems, casinos, sports stadiums, etc.

Harris Multiviewer Installation, Configuration, and Operation Manual 5
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Chapter 1: Introduction

Output Module

Caution

Only qualified service technicians should attempt to service the output
module.

The output module is a self-contained unit that performs all of the system video
input and output processing. It occupies four slots in the output section of any
Platinum routing frame. The multiviewer receives up to 32 baseband

3.0 Gbps video signals or 24 scaled video channels from the frame’s crosspoint
matrix module. A series of fans maintains optimal operating temperature inside
the output module. (Temperatures can be monitored using CCS Navigator.)

The multiviewer’s back module, which is connected to the back of the Platinum
frame, provides all of the connectors for output video signals, communication
devices, and external devices. Each output module can output two DVI and four
SDI video output signals that drive the multiviewer output displays.

For information about the back module connectors, see “Back Module
Connectors” on page 9.

Front view and fan assembly

Back module
connectors

Installation guide Interconnect area
with Ml modules

Figure 1-1. Multiviewer Hardware Output Module

The multiviewer’s main components are:

6 Harris Multiviewer Installation, Configuration, and Operation Manual
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Chapter 1: Introduction

Front view

Installation
guides

Interconnect area

Back module
connector

Front View and Fan Assembly

The output module front has the ejector/locking
mechanism and provides access to the multiviewer’s
serviceable components (see “Front View and Fan
Assembly” on page 7).

Installation guides on both sides of the output module
guide the unit when it is installed in a Platinum frame. For
information about installing the module, see “Installing
Overview” on page 16.

This area provides connectivity to the Platinum frame’s Ml
module. Input signals from the router’s crosspoint modules
are routed to the output module through this connection.

The back module provides all the connectors for external
device connections (see “Back Module Connectors” on

page 9).

The module’s front view provides access to the output module’s LEDs and
alarm indicators. The output module’s fan assembly ensures that the enclosed
hardware is operating at optimal temperature.

Ejector/locking handle

Fan assembly

®
e

Reset button

Monitoring LEDs

Figure 1-2. Output Module Front View

Harris Multiviewer Installation, Configuration, and Operation Manual 7
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Chapter 1: Introduction

Reset Button

USB Connector

Monitoring LEDs

The Reset button restarts the output module without power

cycling the unit. Use the Reset button if starting the unit
from Layout Designer or the Multiviewer Control Panel
failed when a multiviewer needs to be restarted while the
rest of the Platinum frame remains powered up.

Use the USB connector for attaching a USB memory stick

for firmware upgrading or installing new applications.

Monitoring LEDs are located on the front of the output

module. Table 1-1 on page 8 describes the meaning of
each LED.

Table 1-1. LED Status Indicators

LED ﬁ%lli%ration Description

On Solid green The output module is fully powered up.

COM Flashing, green

Solid, red Not currently implemented.

Proc Flashing, green The output module’s Central Processing Unit (CPU)
and Graphic Processing Unit (GPU) are working
properly (heartbeat OK).

Solid, green or red | The CPU is not working properly (heartbeat error).

Flashing, red The GPU is not working properly (heartbeat error).
Drive A Solid, green Internal drive A is working properly.

Solid, red There is an error on internal drive A.

Drive B Solid, green Internal drive B is working properly (Drive B is
reserved for future use and is normally off).

Solid, red There is an error on internal drive B.

Act Flashing, green There is activity on internal drive A or B.

Video In Solid, green

Video Out | Solid, green Not currently implemented.

Net 1 Link | Solid, yellow A valid connection is present on Ethernet connection 1.

Net 1 Act | Flashing, green There is network activity on Ethernet connection 1.

Net 2 Lnk | Solid, yellow A valid connection is present on Ethernet connection 2.

Net 2 Act | Flashing, green There is network activity on Ethernet connection 2.
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Back Module Connectors

The output module back connectors provide all of the connectors for network
and RS-232/422/485 communication, external device inputs, and the output
video signals.

SDI output connectors DVI output

DVI output I connector

connector

For future
For future
use Use
USB 2.0
USB 2.0 e type A
type A t A 5| - connectors
connectors =
DB-26 serig/r”
i 1
connector — | ENETN  BRET =
AES3 audio output Linear timecode input 10/100/1000
connectors Ethernet ports
Figure 1-3. Output Module Back Connectors
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SDI outputs

DVI outputs

USB type A

DB-26 connector

AES3 audio
output

10/100/1000
Ethernet

The four SDI outputs are capable of driving HD-SDI display
devices. The SDI outputs cannot be used in combination
with the DVI outputs. For information about connecting SDI
outputs, see “Connecting Output Display Devices” on

page 63 and “Connecting HDTV Display Devices to the
Multiviewer” on page 65.

The two DVI outputs are capable of displaying a number of
video standards and resolutions. The signals are primary
RGB. The DVI outputs cannot be used in combination with
the SDI outputs. For information about connecting DVI
outputs, see “Connecting Output Display Devices” on

page 63 and “Connecting HDTV Display Devices to the
Multiviewer” on page 65.

These four USB ports can be used for various purposes. You
can use the USB ports to attach a mouse and keyboard to
navigate and control the Multiviewer’s on-screen tools.

This the connector for a breakout cable. The breakout cable
has four DB9 ends to provide four Serial ports. Serial ports 1
and 2 are configured in the software to be RS-232, RS-422,
or RS-485. Serial ports 3 and 4 are fixed RS-232. These
serial ports can be used to connect the multiviewr to Under
Monitor Display (UMD) generators, production switchers,
or other routers. For more information, see “Serial Breakout
Cable” on page 11.

Two AES discrete audio outputs are provided for monitoring
purposes with external audio monitoring devices. See
“Connecting Output Audio Monitoring Devices” on

page 24.

Two Ethernet ports provide connectivity with Layout
Designer and CCS control systems, such as CCS Navigator
and NUCLEUS network control panel. In addition, the Gbps
Ethernet connections can be used to connect the multiviewer
to an external GPI hardware interface such as the JLCooper
eBOX (a 10/100Base-T to Quad RS-232/422 (9-Pin) and
GPI hardware interface. For more information, see
“Network Connections” on page 20.

10
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o

b

.

-

ENET 1 ENET 2
Network Network Network Network
Link LED  Activity LED Link LED  Activity LED

Figure 1-4. Ethernet Port LEDs

Table 1-2. Ethernet Ports LED Status Indicators

LED Color Indication | Description

ENET 1 Network Solid, green A valid connection is present on
Link LED Ethernet port 1.

ENET 1 Network Flashing, yellow There is network activity on
Activity LED Ethernet port 1.

ENET 2 Network Solid, green A valid connection is present on
Link LED Ethernet port 2.

ENET 2 Network Flashing, yellow There is network activity on
Activity LED Ethernet port 2.

External Hardware Components

Back connectors can accommodate external hardware components that provide
additional system connections. Each external hardware component is described
in the following sections.

Serial Breakout Cable

The serial breakout cable expands the back module’s serial port from one
DB-26 connector into four separate DB-9 pin connectors. Ports 1 and 2 can be
configured for either RS-232, 422, or 485. Ports 3 and 4 support RS-232 only.

Harris Multiviewer Installation, Configuration, and Operation Manual

Copyright © 2008-2009, Harris Corporation

11



Chapter 1: Introduction

Figure 1-5 illustrates the serial breakout cable.

DB-26 male connector

Port 1 Port 2 Port 3 Port 4
male (DB-9) male (DB-9) male (DB-9) male (DB-9)

Figure 1-5. Serial Breakout Cable
For information about setting the type of serial connection, pinouts, and making

serial connections, see “Connecting Devices to the Serial Connection” on
page 24.

Third-Party GPI Hardware Interface

Your Harris Multiviewer is compatible with the JLCooper eBOX. The
JLCooper eBOX provides access to up to 24 GPI inputs and outputs. When the
multiviewer is attached to the same TCP/IP network using its own Ethernet
connector, it can access the JLCooper eBOX.

For information about configuring your e-BOX, see your JLCooper eBOX
documentation. See “Configuring JLCooper eBOX in Layout Designer” on
page 49 and “Connecting JLCooper eBOX Devices” on page 68.

12
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Multiviewer Configuration and Control

There are a number of configuration, control, and monitoring options that you
can use with your multiviewer. All multiviewer control, test, and monitoring
capabilities can be accessed remotely using Layout Designer or through CCS
network control options such as CCS Navigator and NUCLEUS Network
Control Panel. Figure 3-1 illustrates a typical control and monitoring scenario.

SDI displays

Platinum routers with DVI displays
multiviewer output modules

Configuration, control
and monitoring with
Layout Designer

Remote control and
monitoring with CCS
networked control devices

CCS Navigator NUCLEUS Network
Control Panel

Layout Designer

Figure 2-1. Harris Multiviewer Configurations and Control
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All control and monitoring communication with the multiviewer occurs through
the output module’s Ethernet port. With the exception of adding the multiviewer
to a router system database, no control of the multiviewer is possible from the
Platinum frame Ethernet connections. You cannot add a multiviewer to a router
system database from Platinum, but you can add it through a PC connected via
Ethernet to a Platinum router.

For information about making network connections, see “Network
Connections” on page 62.

Required and Recommended Software

About Layout Designer

About CCS Navigator

To configure and operate your multiviewer system, you need to have the
following software installed on your local PC:

» Layout Designer (see “About Layout Designer” on page 14)
» CCS Navigator (see “About CCS Navigator” on page 14)

To control and operate your multiviewer system using remote control options,
we recommend that you have CCS Navigator installed on your local PC . CCS
Navigator uses either its CCS-P protocol or SNMP to communicate with the
multiviewer. You can also control and monitor the multiviewer using an SNMP
third-party control system (see “About Remote Control Systems” on page 15).

Layout Designer provides an integrated computer interface for the control and
configuration of one or more multiviewer display systems over a LAN (local
area network). These configuration options include:

» Changing the multiviewer’s IP address and Network Mask
e Setting output display mode
» Calibrating output display devices

Use Layout Designer to select layouts for display, select and change PiP input
sources, and modify layouts and layout objects. Layout Designer also provides
the tools to create and design new layouts and configure monitoring tools such
as audio meters, tally indicators, and audio and video alarms. See your Layout
Designer Software Application User Guide. See also “Discovering Output
Modules Using Layout Designer” on page 29.

Use CCS Navigator to create a database that describes a routing system that
includes your output module. This includes selecting the routing input sources
that are to be available for routing to your output module for display.

See Volume 6 of your Navigator User Manual for detailed descriptions of its
installation and features. See also “Adding Multiviewers to a Router Database”
on page 20.

14
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About Remote Control Systems

The Harris multiviewer is fully compatible with CCS network control systems
such as CCS Navigator and NUCLEUS Network Control Panel. With an
optional license key upgrade, you can control and monitor the multiviewer
using third-party SNMP software. You can remotely perform the following
operations:

» Select and change layouts for display

» Select and change PiP input sources

e Select audio channels for monitoring on the multiviewer’s AES outputs
»  Monitor the multiviewer as well as audio and video signal alarms

» Set audio and video alarm threshold values

»  Change the output module’s IP Address and Subnet Mask

For more information about controlling the multiviewer using CCS control, see
“Controlling Your Multiviewer on a CCS Network” on page 33. For detailed
information about using NUCLEUS to control and monitor your multiviewer,
see your NUCLEUS CENTRIO Control Option Configuration and Operation
Manual. For information on controlling the multiviewer using SNMP software,
see “Controlling the Multiviewer Through SNMP” on page 35.
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Updating Software and Firmware

Your multiviewer comes with all the software and firmware already installed.
However, you may occasionally need to update some or all software or
firmware components.

The following sections outline individual components that can be updated:
e *“Updating the Multiviewer Core Application” on page 19
* *“Updating Layout Designer Software” on page 19

You may also need to update the following non-multiviewer-specific software
and firmware to enable features or functionality with multiviewer:

* Platinum (PT-RES) firmware (see your Platinum Installation,
Configuration, and Operation manual for instructions)

» CCS Navigator (see your Navigator User Manual for more information)

Determining Software and Firmware Versions

You may occasionally want to check software and firmware versions, to
determine if updates are necessary, optional or even available. You may also
want to check software and firmware versions, to ensure that updates were
executed complete and correctly.

To check your software and firmware versions, follow these steps:

1. In Layout Designer, choose Tools > Advanced Configuration.

2. Select the Version tab.

To determine the firmware version, follow these steps:
1. Open Telnet session with the IP Address of PT-RES module.
2. Use the following to connect to the Telnet session:

Login: leitch

Password: leitchadmin

Type: ~showHW

A message similar to the following appears.
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Output Cards
Slot 1
Detected: CENTRIO-S
Slot 2
Detected: CENTRIO-S
Slot 3
Detected: CENTRIO-S
Slot 4
Detected: CENTRIO-M

Configured: CENTRIO-S Version 1.2 Family 003  Product Id 057
Version 1.8  Family 003  Product Id 057
Configured: CENTRIO-S Version 1.2 Family 003  Product Id 057
Version 1.8  Family 003  Product Id 057
Configured: CENTRIO-S Version 1.2 Family 003  Product Id 057
Version 1.8 Family 003  Product Id 057
Configured: CENTRIO-M Version 1.2 Family 003  Product Id 056
Version 1.8 Family 003  Product Id 056

+
Z Note

After the firmware had been updated, the frame must be re-polled again in
CCS Navigator to show the proper firmware version.

Updating Multiviewer (PIPE) Firmware

AWarning

Do not update the Multiviewer PIPE firmware while the Harris Multiviewer
application is running.

-
£ Note

It is very important that you upgrade the Multiviewer’s XVIM PIPE firmware
version to 1.8 or higher, and the PT-RES module to 3.3.b43 or higher.

Exit the Multiviewer application.

Start Navigator.

Select the Platinum frame, and then click Edit.
Select the Firmware tab.

o kM wDd e

Select the output module that is active in the frame (it has a little icon on the
right).

6. Right-click the selected module, and then select Assign from the context
menu that appears.

¥
£ Note

You can select multiple Multiviewers by holding down the CTRL key and clicking
on each module.

7. Inthe list, select all of the output modules in a zone.
Updating will not span zones.

8. Right-click the selected module, and then select Change Firmware from
the context menu that appears.

Harris Multiviewer Installation, Configuration, and Operation Manual 17
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9. Browse to the RtrWrks/Bin32/Firmware folder and select the
CENTRIO_xxxx.zip file.

10. Click Upgrade or Upgrade All and wait for a Firmware upgrade
successful message.

s
£ Note

While the firmware is updating, the corresponding Multiviewer will restart
twice.

Upgrading the Display Driver
1. Copy the install folder to USB memory stick and insert it into the output
module’s USB port.
2. Double-click SETUP.EXE.

~¥
£ Note

If the upgrade fails from USB memory stick, try again from USB or copying
the folder on the multiviewer’s C: drive and double-click the SETUP.EXE
file.

The upgrade process may reset the display resolution. If the resolution is not
restored when the Multiviewer application starts, then you may need to open the
NVIDIA Control Panel and change the display resolution settings accordingly.

For 1080i: select 1920 x 1200
For 720p: select 1280 x 720

Upgrading Multiviewer Drivers and FPGA Firmware
1. Connect the USB mouse to the Multiviewer.

2. To exit the Multiviewer, right-click to open the Multiviewer Control Panel,
and then click Explorer.

3. Browse to the location of the DriversFPGAs folder.
Double-click UpgradeAll.bat.

Four messages appear during the installation. Click Continue Anyway
each time to proceed.

The H/W Upgrade dialog box appears. This upgrades XVIMs in parallel.

5. When the first Flash file is updated, click OK to continue with the second
Flash file update.

Once completed, the process will continue to update other software components
and the computer will restart automatically.
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Updating the Multiviewer Core Application

You must uninstall the Multiviewer Core Application before installing an
updated version. If you cancel the uninstallation process, you will not be able to
install an updated version of the software.

1.

Browse to the location of the Multiviewer Core Application *.msi file (if

using Windos XP) or *.exe file (if using Windows Vista), and then
double-click the file.

An Application Maintenance dialog box opens.

Choose Remove, and then click Next.

On the Multiviewer 3.x Uninstall dialog box, click Next to continue the
uninstall process.

A progress bar appears on the screen.

When the uninstallation process is done, click Finish.

Return to the location of the Multiviewer Core Application *.msi file (if

using Windos XP) or *.exe file (if using Windows Vista), and then
double-click the file again.

A Welcome to the Harris Multiviewer 3.0 Installation Wizard dialog
box appears.

Click Next, and then follow the instructions that appear on the screen to
install the updated version of the Multiviewer Core Application.

Updating Layout Designer Software

You must uninstall the Layout Designer software before installing an updated
version. If you cancel the uninstallation process, you will not be able to install
an updated version of the software.

1.

Browse to the location of the Layout Designer *.msi file (if using Windows
XP) or *.exe file (if using Windows Vista), and then double-click the file.

An Application Maintenance dialog box opens.
Choose Remove, and then click Next.

On the Layout Designer 3.x Uninstall window, click Next to continue the
uninstall process.

A progress bar will appear on the screen.
When the uninstallation process is done, click Finish.

Return to the location of the Layout Designer *.msi file, and then
double-click the file again.

A Welcome to Layout Designer 3.x Installation Wizard window appears.

Click Next, and follow the instructions that appear on the screen to install
the updated version of Layout Designer.

Harris Multiviewer Installation, Configuration, and Operation Manual 19

Copyright © 2008-2009, Harris Corporation



Chapter 2: Configuration and Operation

Creating a Backup Settings Folder

The purpose of a Backup Settings folder on a multiviewer is to store a copy of
the three key XML files as a backup. If the Multiviewer application detects any
corruption in an XML file, it will copy the backup file from from the
BackupSettings folder to replace the main file. If the file does not exist in the
BackupSetting folder, then the Multiviewer application will create a new file
with the default settings.

The three XML files are in the C:\Program Files\Harris\Harris Multiviewer
folder:

e Settings.xml
»  Configuration.xml
e Persistence.xml

Create a BackupSettings folder in the Centrio folder. The path name will look
like:

C:\Program Files\Harris\Harris
Multiviewer\BackupSettings

Once you have completed configuring your multiviewer completely, copy the
three XML files to the BackupSettings folder.

Adding Multiviewers to a Router Database

After installing an output module in a Platinum router frame, you must
configure a router matrix that includes your multiviewer output module. Using
Navigator’s routing components, you can either create a new router matrix that
includes your output modules, or you can add output modules to an existing
routing matrix. Adding output modules to the routing matrix defines which
router inputs will be used as input source audio and video.

The information below describes the different methods by which you can add an
output module to a router database. It does not go into detail about any of these
methods or about other aspects of editing a router database. For more
information, please refer to the Volume 6 of your Navigator User Manual.

~¥
£ Note

To complete this task, you should have a working knowledge of Navigator.

Adding Output Modules by Polling

The Poll option queries the control system for any programmable devices
present in the system. Polling obtains information about the current
configuration of each physical device, and compares it to the information found
in the database to determine if the database information matches the actual
configuration.

1. Start Navigator.

20

Harris Multiviewer Installation, Configuration, and Operation Manual
Copyright © 2008-2009, Harris Corporation



Chapter 2: Configuration and Operation

2. Right click on Routers in the Navigation pane, and then select Create >

Routing System from the context menu.
The New Routing System Configuration dialog box opens.

Create Routing System

Mew Routing System

Hame: |

Create Options
(% Start from a blark comfiguration
(™ Use an ewisting Routerd apper DA4 file or a routing system backup file

" Use a configuration from a remote router server

Connection: |TCF';"IF' ﬂ |

QK. | Cancel | Help |

Figure 2-2. Create Routing System Dialog Box

3. Inthe Name field, enter a name for the routing system.
This is the name that will appear in the Navigation window.

4. Under Create Options, choose Start from a blank configuration.
This selection allows you to designate a new routing system, and then
populate it manually or with a system poll.
Place a check beside Perform System Poll.
In the Connection field, choose TCP/IP, and then enter the IP address for
your Platinum PT-RES module.
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7. Click OK, and then wait while Navigator searches the network.

When the search is complete, a series of folders appear under the name you

provided in the Navigation pane.

—1CO Control Yiews .
£ My € Database Editor

)

+ 1] Software Control Panels
1 Salvos
—1C1 Routers
SEE Platinum 0 € Frame icon
—}-C3 Output Cards
Slat 1 - PM-HSR-0B
Slat 2 - PM-HSR-0B
Slat 3 - PM-HSR-OB
Slot 4 - PM-HSR-OB
Slat 5 - PM-HSR-0B
Slat & - PM-HSR-0B
Slat 7 - PM-5R-0B
Slot 8 - PM-SR-0B
Slat 10 - PT-HSR-0BG+x
Slat 11 - PM-AEST-0B
Slat 16 - CENTRIO-M
+-_ Input Cards
+1-0 Croszpoint Cards
+1-C0 Control Cards

Figure 2-3. Routers Folder in the Navigation Pane

8. Right-click the Frame in the Routers folder, and then select Poll.
Wait while Navigator polls the device.

9. When the frame poll is complete, double-click the Frame in the Routers
folder.

The Edit Platinum Frame dialog box appears.
10. On the Configured Matrices tab, click Add.
The Add WB Matrix dialog box appears.
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11. Under Matrix Type, select MultiView.
The dialog box updates to display only multiviewer-related settings.

Add Centrio Matrices EJ

b atris Tppe:

ultiview v

Farmnat: # Centrio Modules:

MDDl v | ]
# of Physical INs: Starting Centrio Slat:

| 256 ~| 5wt ~|

1/0 Card & Slats
&+ Auto ™ Manual

Input Card Type: Input Pluging:

| [

Starting IM Slot:

#IM Slots:

Ok | Cancel |

Figure 2-4. Configuring CENTRIO Matrix Settings

12. On the Add Centrio Matrices dialog box, do the following:

a. Under # Centrio Modules, select the number of installed CENTRIO
output modules.

b. Under Starting Centrio Slot, select the first slot in which the top-most
CENTRIO output module is installed.

c. Under # of Physical Ins, select 0.

13. If required, make any changes to other settings in the dialog box, and then
click OK.

In the Edit Platinum Frame dialog box, two different types of multiviewer
selections have been added: CENTRIO V for the underlying CENTRIO
video matrix, and CENTRIO PIPs for the virtual CENTRIO matrix.

14. Multiviewers are placed in the graphical representation of the frame from
the top down. To realign them in their correct positions, right click a
CENTRIO module and select Unassign from CENTRIO V, and then click
on the top row where the CENTRIO device should appear (Centrio modules
being four slots tall), right-click again, and select Assign to CENTRIO V.

15. Select the range of video inputs to assign to CENTRIO, then right-click and
choose Assign to CENTRIO V.

Harris Multiviewer Installation, Configuration, and Operation Manual 23
Copyright © 2008-2009, Harris Corporation



Chapter 2: Configuration and Operation

16.

17.

18.
19.

20.

21.

To add audio, right click on the audio inputs, and select Assign to
CENTRIO V.

To configure the level and output offsets (if required), highlight CENTRIO
V, and then click Advanced.

The Matrix Partition dialog box appears. By default the output offset is
equal to the size of the frame.

Make any necessary changes to this screen, and then click OK.
Highlight the same slots, right-click, and then select Change Format.
The Select 1/0 Card Type dialog box opens.

Select /0 Card| Type [z|

Format: Input Card Type: Cukput Card Type:
AES ol P T-2E5T-1B

Input Plugins: Cukput Plugins:

ok | Cancel

Figure 2-5. Changing Audio Input Format

Under Format, select the correct audio format, and then click OK.
This creates a CENTRIO A audio matrix.

Highlight the slots that contain audio input modules, and then right-click
and select Assign to CENTRIO V.

Configuring Multiviewers in Database Editor

1.

To open the Router Database Editor, double-click on the item inside the
routing system’s Control Views folder.

In this dialog box, you can make the following changes:

e “Configuring UMD names” on page 25

e “Configuring Discrete Audio Inputs” on page 25

»  “Creating Destinations Representing Actual PiPs” on page 26

»  “Setting Up PiPs to Follow Destinations” on page 26

When your changes are complete, click Save, and then close the dialog box.
Right-click the frame in the Routing system, and select Download.

This loads the changes to the frame.
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Configuring UMD names

On the Sources tab of the Database Editor dialog box, change the contents of the
Name column to change the UMD names of devices on the multiviewer.

Configuring Discrete Audio Inputs
To map the video and audio in CENTRIO, do one of the following:

» To configure discrete audio inputs in Stereo Breakaway mode (default), on
the Sources tab, configure the audio logical IDs as in Figure 2-6.

= —— - 1
| =7 Contiguration for Multiviewer =JEEd
wld B2 A . R et Sl M R DT L oe Sl usmies = 1
Sourcmn | Dedtnationg  Levels  Colganed
L] 1] T T H 1 ] K i 5] A n [ 0 ! |
Level Lewed £ Lewed 3 Leveld _I |
Stmwce Sk Lovg Fsme | Bmage et ripptban -, “ — b
Blatis Bl lias Sralu Stalus
Indess Indes | HE e Indew | SHA Indimy
1 D sl i el 1 % T C 1 ned [ e
% T Srel 2 el 5 Srel L] Sl T SeT L] Sl
3 b ] Bre 3 2 =l L] . (e 1o e lo 1) . ETll = Brar
2 i facd o el (k] d |h.-|: 14 e 14 (L} L |EE it e 10
P e 5 wed 1 [ i 1 N 1 S W = S
|
|
" [ Sed A i d i i!ll 21 = LY B Hal e X - Sl
- I 7 T Me 7 = BT = |smwan Fol ] » a7
. @ ) i el = i 20 n e 30 1 WX 1 e
. [ 1] 0 | mcd 1 RETE] ™ e = Rt ] = e
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x| il 12 o - !u.- a5 - x4 a7 BT ar e An
i _ :'
- P |

Figure 2-6. Logical ID Settings for Stereo Breakaway Mode with Discrete Audio Inputs

» To configure discrete audio inputs in RGB mode:
a. double-click the Frame in the Routers folder.
The Edit Platinum Frame dialog box appears.
b. Select the CENTRIO A, and then click Advanced.
Under Partition Type select RGB/Stereo.

From the # of Partitions menu, choose the number of mono pairs of
discrete audio per video.

e. Assign the level of each component so that each pair is on its own level.
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f. Inthe Database Editor screen, click the Sources tab and configure the
audio logical IDs as in Figure 2-7.
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Figure 2-7. Logical ID Settings for RGB Mode with Discrete Audio Inputs
g. Click OK.

Creating Destinations Representing Actual PiPs
1. Select the Sources tab in the Database Editor.

Make sure the CENTRIO video matrix (CENTRIO V) and virtual matrix
(CENTRIO PIPs) are mapped to the same sources.

2. Edit the PiP destinations as required.

Information on different methods of editing your PiP destinations is
included in Volume 6 of your Navigator User Manual.

3. Ensure that the correct destination names appear (or are assigned) to the
correct control device(s).

Setting Up PiPs to Follow Destinations
1. In the Database editor, click the Levels tab.
The Edit Levels dialog box appears.
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2. Beside Destinations, choose the number of destinations you want the PiPs
to follow.

This will be less than the default.
3. Click OK.
Double-click the Frame in the Routers folder.
The Edit Platinum Frame dialog box appears.
5. Highlight the CENTRIO PiPs entry, and then click Advanced.
The Matrix Partition dialog box appears.
6. Change the Output Offset entry to 0.
Click OK, and then OK again.
7. On the Database Editor screen, click the Destinations tab.

Check to make sure destinations are now mapped to Matrix 1, and to the
CENTRIO PIP Matrix.

Now, when you switch a destination, you will not only switch the output
destination, but also the source displayed on the CENTRIO PiP. This
changes the PiP 1 parameter available in CCS Navigator or a NUCLEUS
control panel. See “PiP Parameters and Alarms” on page 40 for more
information.
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Configuring Multiviewers in a Local Area Network

The default IP address for your output module is 192.168.100.250. You can use
this IP address to connect your output module directly to Layout Designer or
add the output module to your network. Once you have added the multiviewer
to your network, you can change the output module’s IP address to suit your
network requirements.

If you have more than one output module installed in your Platinum frame, you
must go through the process of discovering and changing the IP address one
output module at a time.

~F
= Note
Each multiviewer on the network must have an unique IP address.
Configuring multiviewers on a local area network includes the following steps:

I. Discovering output modules using the default IP address. This may involve
first configuring the Layout Designer PC to be on the same subnet as the
multiviewers. See “Adding the Multiviewer to the Layout Designer Devices
List” on page 29 and “Preparing to Add Your Output Module to the Devices
List” on page 29.

2. Changing output modules’ IP addresses from their defaults to addresses that
are within the range of the rest of your network. See “Changing the Output
Module IP Address” on page 30.

3. Returning the Layout Designer PC to its original IP and subnet settings. See
“Returning the Layout Designer PC to its Original IP and Subnet Settings”
on page 32.

,__"F
2 Note

You can also use CCS Navigator to change the output module Ethernet 1 IP
address. For more information, see “Discovering Output Modules Using
Navigator” on page 33.

Output modules have two Ethernet connections: Ethernet 1 and Ethernet 2.
Only Ethernet 1 is assigned the default IP address, so ensure that this port is
used to connect your output module to the Ethernet port of your local PC or
network connection or hub.
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Discovering Output Modules Using Layout Designer

You can discover an output module by adding its default IP address to Layout
Designer’s Devices. You can connect Layout Designer to the output module,
and then change the output module’s IP address.

<%
2 Note

After you discover the module, change its IP address using Layout
Designer. If you have not yet installed Layout Designer on your local PC, do
so now. See the Layout Designer Software Application User Manual for
more information.

When you use the Discovery tool to add output modules to the device list,
Layout Designer scans the network and reports all devices with an IP address.
The amount of time required for discovery depends on the number of devices
you have on your network. Layout Designer may discover devices that you do
not want to add to the devices list.

Preparing to Add Your Output Module to the Devices List

Before adding an output module to the Layout Designer Devices list, ensure that
it is connected to the Layout Designer PC.

The PC can be directly connected to the output module using an Ethernet
cross-over cable, or directly connected to the same hub or switch as the
multiviewer using a normal Ethernet cable.

To connect your Layout Designer PC to an output module at its default IP
address, follow these steps:

1. Make note of the IP address, subnet mask, and default gateway settings on
your Layout Designer PC.

2. Change the network settings on your PC to the following:
* IP Address: 192.168.100.100
*  Subnet Mask: 255.255.255.0
» Default Gateway: Blank

After you have configured the output module’s IP address for your network, you
will need to return the PC to its original settings. See “Returning the Layout
Designer PC to its Original IP and Subnet Settings” on page 32.

Adding the Multiviewer to the Layout Designer Devices List
1. Start Layout Designer.
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2. From the application menu, select File > New > Configuration.
The Device Manager dialog box appears.

x

— My Devices

Add Device I Delete Device | Delete All Devices | Advanced Configuration |

Select  Dewice MName IP Address Digplay Connected

e IDevice Hame 1 I . . . |1 ﬁ Test ?

Figure 2-8. Entering the Multiviewer’s Default IP Address

3. Click Add Device.
A new device appears in the Device list.
Under Device Name, you can enter a new name for the output module.

5. Under IP Address, type 192.168.100.250, which is the output mode default
IP address.

6. Under Display, enter the display number onto which your layouts will be
published.

In most configurations, the Display value should be set to 1. It can be set to
1 or 2 for Dual DVI and Dual SDI, and 1 to 4 for Quad SDI.

7. To connect the output module to Layout Designer, click the Test button.

«  If the connection is valid, the ¥ icon is displayed under Connected.

» If the connection is invalid, the A icon is displayed under
Connected.
—
# Note

If your connection is reported as invalid, check the default IP address you
entered, the IP address of your PC, and your Ethernet connections, and then
click Test to test the connection again.

8. After you establish a valid connection, click Save to save the list and

connection information. You can change the IP address of your output
module using Layout Designer’s Advanced Configuration dialog box.

Changing the Output Module IP Address

Use Layout Designer’s Advanced Configuration dialog box to change an
output module’s IP address. (You can also use CCS Navigator to change your
output module’s IP address. For information, see “Discovering Output Modules
Using Navigator” on page 33.)
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To change the output module IP address

1. From the Device Configuration dialog box, click Advanced
Configuration.

The Advanced Configuration dialog appears.

2. Under Device Name, select your new output module, and then click the IP
Settings tab.

|23 Adwanced Configuration A& x|
TErrT— Extarrual Darvic s Vresian Scasrce LMD NTR
G e | saay P Tetrgs Mgt elarens
orat |
IF Addras
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Gatewaay
[ Sz
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&) EMET B Agdress
O INET
4 *
[ cancel |

Figure 2-9. Changing the Multiviewer’s Default IP Address

3. Under Ethernet 1, delete the information that appears in the IP Address
and Subnet Mask fields, and then enter the IP Address and Subnet Mask
that you want to use for the output module.

Leave all the fields of Ethernet 2 blank unless it is used to connect the
multiviewer to devices on another LAN. If Ethernet 2 is going to be used,
repeat step 3 for Ethernet 2, entering the different IP Address and Subnet
Mask.

4. If your multiviewer communicates with the PT-RES module through
external cables, click ENET, and then enter the IP address of the PT-RES
module.

INET communicates with the PT-RES through the internal bus, and does not
require you to enter IP address.

5. Click Done.

Repeat the steps described in “Adding the Multiviewer to the Layout Designer
Devices List” on page 29 and “Changing the Output Module IP Address” on
page 30 for each output module that is installed in your Platinum router frame.
When complete, you can use Layout Designer’s device discovery tool to add
each output module to the Devices List. See “Adding New Devices” on page 32.
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Returning the Layout Designer PC to its Original IP and Subnet Settings

Adding New Devices

If you changed your Layout Designer PC IP address to communicate with the
output module at its default IP address, and you have successfully changed the
output module IP address, you can now change the Layout Designer PC IP
address, subnet mask and gateway settings to the original settings that you
recorded in “Preparing to Add Your Output Module to the Devices List” on
page 29.

After you have assigned your output module a unique IP address, you can use
Layout Designer’s Discovery tool to add the output modules to the device list.
Be aware that when you use the Discovery tool, Layout Designer scans the
network and reports all devices with an IP address. The amount of time required
for discovery depends on the number of devices you have on your network.
Layout Designer may discover devices that you do not want to add to the
devices list.

Vv

# Note
Before attempting to discover your output module, ensure that you have
returned your PC’s IP Address, Subnet Mask, and Gateway Address to their
original network settings (see “Returning the Layout Designer PC to its
Original IP and Subnet Settings” on page 32).

To discover output modules

1. On the Device Manager dialog box, under Device Discovery, click
Discover Devices.

2. When the discovery is complete, do either of the following:

» To add specific devices, select the devices that you want, and then click
Add to My Devices.

» To add all of the discovered devices, click Add All to My Devices.
The selected devices are now in the Devices list.

3. When you finish discovering and adding devices to the Devices list, click
Save.

You can now configure your multiviewer’s outputs. See “Configuring
Multiviewer Outputs” on page 45 for more information.
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Controlling Your Multiviewer on a CCS Network

You can use CCS Navigator and the NUCLEUS Network Control Panel to set
CCS controllable parameters on your Harris multiviewer. CCS parameters allow
you to select layouts, modify some layout attributes as well as monitor feedback
from multiviewers. Using CCS Navigator, you can also monitor various
hardware alarms, such as operating temperature alarms, as well as monitor the
integrity of audio and video input signals.

Each output module, system, and associated PiP has its own set of parameters
and alarms. Before you can access these parameters and alarms, you must
discover the output module using CCS Navigator.

The following sections describe how to discover an output module and how to
control and monitor it using CCS Navigator. For information about controlling
output modules using NUCLEUS network control panels, see your NUCLEUS
CENTRIO Control Option Configuration and Operation Manual.

Discovering Output Modules Using Navigator

You can use CCS Navigator in Build mode to discover output modules that are
connected to a CCS network.

To discover a output module

1. Make sure Navigator is in Build mode by selecting File > Operational
Mode > Build.

2. If the Discovery Window is not open, click Tools > Discovery in the main
menu.

The Discovery Window appears, most likely in the bottom left corner of
the screen.

3. Click Options, and then click Add.
. Enter the IP address of the output module you want to discover.

5. Click OK to close the Add Host dialog box, and then OK again to close the
Discovery Options dialog box.

6. Click Start.
Navigator runs a discovery.

7. When your discovery is complete, Discovery Completed is displayed in
the Discovery Window.

8. Click Save.

The contents of your discovery populate the Discovery folder of the
Navigation Window.

You can now switch to Control mode by selecting File > Operational Mode >
Control from the main menu. Depending on which output module parameter set
or alarm group you want to view, double-click on the appropriate icon in the
Navigation Window to display the system, module, or PiP controls.
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Figure 2-10 illustrates a discovered output module.
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Figure 2-10. Discovering an Output Module

The following sections describe the multiviewer-related icons that appear in the
Network view after you discover an output module.

0 Click this icon to expand the discovered CENTRIO multiviewer folder.

@ Double-click the CENTRIO system icon while in Control mode to display
the system-related parameters and alarms in a Control window. For
information about CENTRIO system parameter and alarms, see
“Multiviewer System Parameters and Alarms” on page 39.

9 Double-click the Layout Designer icon to start Layout Designer. For more
information, see your Layout Designer Software Application User Guide.

@ Click the PiP icon to expand the PiP folder to display all the PiPs associated
with the currently active layout. When in Control mode, you can
double-click on the individual PiP icons to access individual PiP parameters
and alarms in a Control window. For more information, see “PiP Parameters
and Alarms” on page 40.

6 Double-click the CENTRIO module icon to display the module related
parameters and alarms in a Control dialog box. For information about
module parameter and alarms, see “Multiviewer System Parameters and
Alarms” on page 39.
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Controlling the Multiviewer Through SNMP

Configuring a Harris Multiviewer as an SNMP Agent

You configure your multiviewer as an SNMP agent from Control Panel >
Administrative Tools > Services (Local).

1. Right-click on the display and select Exit Multiviewer to close the
Multiviewer application.
2. On th Multiviewer Control Panel window, click Command Prompt.
3. Type the following:
services.msc
The computer management Services dialog box opens.
T =101
Fle  &cten Wew  Help
rn[ﬂ@lﬂ@ ¥ ¢ W Il Ep
o
Gt 4 B e B¢ Senrighen,  Meme |esrption | stus | Setpiype | togonas | j
By KT Bourkime ptin.,. Miorosaft ..., Marnadl Local System
i sk Virtkon Cum ... Addodes e, Mol Lot Smrve
g tierter ot 3. Dirabied Letel Sevve
ﬁnfq)ielbb*}w\cr Provdes the..  Sharted [l Local System
TRy hopleaton Liper ... Provadss e, Teated  Masud Lacel Garvce
hcphcation Manage. .. Provides & Mermal veaeal Srem
mnsn.l.cr-amm-f. Prossdes 5., M Mebwor 5. .
By Moty Poller Aok Local System
%n.n:un Igxiate Fruataes th. S ] A iariate Lex ol Sepltem
oot Ibeby. . Tramfers .. Baled  Mamud Lot Sritem
Rhboniour Service Dorjour ... Sharted  Autnmatc Local System
By Carariatandar Tewtad  Autoral Laesl Speten
Byl e Fruataleri Ch... Dbl el Srem
Wy O0Me Event System  Suppors 5., Stabed  Manudl Local System |
r,|H.h|Awl1f [, TP S ar | Y P—— P R S—
Figure 2-11. Services Dialog Box
4. Under Services, right-click on the SNMP Service and select Properties.
5. On the Traps tab, type a community name (usually Public).
6. Click Add to List.
7. Click Add, and then type the IP address of the SNMP Manager unit in the
Traps Destination field.
Click Add, and then click Apply.
Click OK.
In the Computer Management Services window, the Status field should
display SNMP Service Started.
10. Click Start Multiviewer to restart the Multiviewer application.
11. Click Launch Multiviewer.
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Configuring Third-Party SNMP Software Control

To set up your multiviewer with optional SNMP to communicate with SNMP
MIB browsing software, follow these steps:

1. Make the required network connections between the output module(s) and
your PC with installed SNMP browser/control software.

2. Ensure that your output module is configured to send traps to the computer
that contains your MIB browsing software.

3. Forinformation on configuring SNMP on the output module, see
“Configuring a Harris Multiviewer as an SNMP Agent” on page 35.

4. Load the Leitch mibs (downloadable from our website) into your SNMP
browser/control software:
e leitch.mib

This MIB sets up the basic structure for product specific MIBs. It can be
found under the Private > Enterprise branch in your MIB browsing
software, and sets up the leitchProducts and leittchCommon
sub-branches.

The leitchCommon branch is initially empty. The leitchProducts
branch contains three initially empty sub-folders: LeitchX75, NEO and
fam6800plus.

e ccsAlarm.mib

This MIB adds a ccsAlarms sub-branch to the leitchCommon folder.
When it is installed, you will be able to determine what specific module
or frame has triggered an alarm (trap).

These general MIB files set up a structure to help define parameters (as
SNMP objects, and alarms as SNMP traps.

5. Load the Multiviewer MIBs (downloadable from our website) into your
SNMP browser/control software:
+ CENTRIOMODULE.mib

Loads the parameters and alarms listed in “Multiviewer System
Parameters and Alarms” on page 39.

* CENTRIOSYSTEM.mib

Loads the parameters and alarms listed in “Multiviewer System
Parameters and Alarms” on page 39.

* PIP.mib
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7.

Loads the parameters and alarms listed in “PiP Parameters and Alarms”

on page 40.

The Multiviewer MIBs will appear in the CENTRIO folder under the

LeitchProject folder.

SNMP MIB Browser

@ [1]internet
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Figure 2-12. Multiviewer MIBs Loaded into NUDesign MIB Browser

Configure your MIB browser to connect to the output module by entering

the IP address, Port (if you have changed the Port from its default in the

configuration), and other standard configuration settings.
Your browser should now connect to the SNMP agent running on the output

module.

To receive traps, start up the trap receiver in your MIB browser software.

To verify that your configuration is correct, browse to Private > Enterprises >
Leitch on the MIB tree, and then right click on the Leitch heading and choose
Walk.

You will see all the parameters and alarms for the device. .
To facilitate monitoring more than one multiviewer, MIBs index devices by IP

address. These settings will be available in your SNMP manager. See your
SNMP manager’s documentation for details of how to customize its

configuration.
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Parameters and Alarms

Parameter Table Notes

Use CCS Navigator in Control mode or NUCLEUS network control panel to
access CCS controllable parameters and alarms. Output modules have no
card-edge controls. You must discover the output module before you can access
CCS parameters and alarms (see “Discovering Output Modules Using
Navigator” on page 33).

Output module alarms function in the same way other CCS device Smart
Alarms operate. For information about how CCS Alarms work, see your CCS
Navigator documentation. Additional audio and video alarms can be viewed on
display layouts and with Layout Designer software. See your Layout Designer
User Guide for more information about configuring and viewing on-screen
audio and video alarms.

Output module parameters and alarms are divided into the following Navigator
Control Window tabs.

Wiew For Administrator [Administrators Group)

qﬂ Metwork

- J Centrio Multiviewer [137.237.173.15)

B Centio System 0 ¢————— Parameters for the multiviewer séystem as
CENTRIOD Layout Designer a whole appear in “Multiviewer System
S0 FPs Parameters and Alarms” on page 39.

[ Fr1FF_1)
[ Fr1mPP_2
[l Fri@ PP
M rr13PF 1 e«— Each PiP has a separate control window.
Fl PP 1 4 [PIP_S] The contents are described in “PiP
A FP1 ) [PIP'B] Parameters and Alarms” on page 40.
L -

1 Modules
Slot 1 - Centrio Module 0 ¢———— Parameters for an individual output )
<1 Centio System 1 module (of which there are four) appear in
_ “Multiviewer Module Parameters and
+ E Centria System 2 Alarms” on page 43.
+ E Centrio System 3

Figure 2-13. Multiviewer Devices That Launch Control Windows

The parameters are listed in the order that they appear in CCS Navigator.
When viewing the control parameter tables, observe the following:

» Shaded table rows indicate read-only (feedback) parameters. Some
Read-only parameters can be modified using Layout Designer.

» Bold parameter options indicate the default settings for the parameter.
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Multiviewer System Parameters and Alarms

If your multiviewer has been configured for Independent mode (one layout for

each DVI output display) using Layout Designer, two system icons appear in
the Discovery folder. Each system has its own set of parameters alarms. To
access the system parameters and alarms, in the Network view, click the
multiviewer’s system icon, and select either the Parameters or Alarms tab.

_‘F
£ Note

See the Multiviewers Configuration chapter in your Layout Designer
Software Application User Guide for information on configuring for

Independent mode.

Table 2-1 lists the system parameters, and Table 2-2 on page 39 lists system

alarms.

Table 2-1. Multiviewer System Parameters

Parameter Name

Function

Options

Parameters

System Name

Displays the name of the current Multiviewer system

(displayed system name)

Active Layout Name

Displays the name of the layout that is active on the
selected system (lists all layouts stored on the
Multiviewer module)

(name of currently active
layout)

Number Displays

Shows the number of display devices currently
connected to the selected Multiviewer system

(number of displays)

Initial Counter Time Determines the start time of any counters (00.00.00.00)
Lock Display Disables on-screen controls on the output module « Disable

* Enable
Parameters > Virtual GPI
Virtual GPI (1-16) Renders the specified virtual GPI as active or inactive |* Disable

» Enable

Table 2-2. Multiviewer System Alarms

Alarm Name Description

System Major Summary

Active if any alarm condition is reported
(priority > 7) for the system

System Minor Summary

Active if any alarm condition is reported
(4 < priority < 7) for the system

module

System Communication Failure | Master module has lost connection to a slaved

System LTC Failure

System lost LTC input, if configured

System GPIO Failure
configured

System lost connection to external GP1O device, if
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PiP Parameters and Alarms
You can access PiP parameters and alarms for each PiP that is associated with a

Table 2-3. PiP Parameters

currently active layout.

To access the PiP parameters and alarms

1. Inthe Network view, double-click or expand the PiP folder.
Each PiP associated with the layout is listed in the Network view.

2. To access an individual PiP’s parameters, click the PiP icon, and in Control

mode, click the Parameters tab.

3. To view a consolidated list of PiP alarms, click the Alarms tab.

Table 2-3 lists the CCS parameters for each PiP.

Parameter Name Function Options

Parameters

Name Displays the PiP name String (always shows PiP)

Static Displays the label text on the selected PiP String (displayed label text)

Display Identifies which output display device is currently String (display name)
displaying the selected PiP

Dynamic Displays the source ID for the UMD source String (UMD source ID)

Source Name

Selects the input source name for the PiP

Drop-down list with all
sources listed

Source Number

Displays the source number for the selected PiP

Slider (1 to maximum
source number)

Source ID

Displays the source ID for the selected PiP

String (source ID)

Full Screen Enable

Activates/deactivates full-screen view of the selected
PiP

* Enable
* Disable

Video Present Status

Displays the presence of a video input signal on the
PiP’s input source

(displays Absent or Present)

Video Standard Status

Displays the detected video standard of the PiP’s input
source

(displays input standard
status)

Aspect Ratio

Displays the detected video aspect ratio of the PiP’s
input source

(displays aspect ratio)

Test and Measurement

(These parameters will not appear if your hardware does not support this feature)

Color Source

Sets the default color dislay to to From Video (color)
or Monochrome (black and white)

* From Video
¢ Monochrome
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Table 2-3. PiP Parameters (Continued)

Parameter Name

Function

Options

Display Scope

Determines what type of scope is displayed

¢ None

» Waveform

» Waveform Parade
e Line

« Line Parade

e \ector

* Quad Display

Video Line

Select which line of the active video to evaluate

(varies depending on input
resolution)

Zoom Range X Min

Determines the start of the display, if you only want to
view a portion of the video line

(varies depending on input
resolution)

Zoom Range X Max

Determines the end of the display, if you only want to
view a portion of the video line

(varies depending on input
resolution)

Field Select Determines which video field (in interlaced formats « Even
only) e Odd
Audio Monitoring
AES Output Selects the AES output to configure for monitoring * AES1
« AES2
Channel 1 Selects which audio you want to output for audio 1to 16
monitoring in channel 1
Channel 2 Selects which audio you want to output for audio 1to 16
monitoring in channel 2
Stereo Pair Selects which audio pair from the selected audio + Channel1 &2
channel you want to output for audio monitoring (this | * Channel 3 & 4
control will set channel 1 and channel 2 appropriately) |+ Channel 5 & 6
e Channel 7 & 8
+ Channel 9 & 10
* Channel 11 & 12
* Channel 13 & 14
* Channel 15 & 16
Monitor Enables or disables audio monitoring * Disable
» Enable

PiP Location

position in the layout.

X Offset Displays the offset value of the PiP’s horizontal (x) (offset value)
position in the layout
Y Offset Displays the offset value of the PiP’s vertical (Y) (offset value)
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Table 2-3. PiP Parameters (Continued)

Parameter Name

Function

Options

X Size

Displays the value of the PiP’s horizontal (X) position | (value)

in the layout.
Y Size Displays the value of the PiP’s vertical (Y) position in | (value)
the layout.
PiP State Indicates if the PiP is active in the layout « Disabled
» Enabled
Table 2-4 lists PiP alarms.
Table 2-4. PiP Alarms
Alarm Name Description
Global Video Summary Active if any video alarm is reported
Global Audio Summary Active if any audio alarm is reported
Global Tally Summary Active if any tally alarm is reported
PiP Audio Ch 1 Missing - An audio signal is not present on the PiP audio
PiP Audio Ch16 Missing channel indicated (Ch1-Ch16).
PiP Audio Ch 1 Peak - The audio level on the PiP audio channel indicated
PiP Audio Ch16 Peak (Ch1-Ch16) is over the set peak threshold value.
PiP Audio Ch 1 Low - The audio level on the PiP audio channel indicated
PiP Audio Ch16 Low (Ch1-Ch16) is under the set low threshold value.
PiP Audio Ch 1 Silence - The audio level on the PiP audio channel indicated
PiP Audio Ch16 Silence (Ch1-Ch16) is under the set silence threshold value.
Audio Group 1 Missing - The specified audio group is not present....
Audio Group 4 Missing
Format Change Indicates that the video input format has deviated
from its defined standard
SD EDH Error Reports recurring EDH errors in the standard
definition video signal
HD CRC Error Indicates that the internally calculated CRC value is
different from the received CRC value
Loss of Video Indicates that the multiviewer hardware can no
longer detect a video signal from the video channel
CC Missing Indicates that closed captioning (can be HD or SD)
is not present in the incoming video stream
CC Not Updating Indicates that closed captioning is not updating
correctly in the incoming video stream
WSS Missing Indicates that WSS is not present in the incoming
video (should be present in SD625 only)
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Table 2-4. PiP Alarms (Continued)

Alarm Name

Description

Video Freeze

Indicates that the input video image is frozen
(static) according to user-defined frozen picture
delay (duration), percent of frozen video in the
frame, and amount difference between pixels
percent tolerance

Video Black

Indicates that the input video image is considered a
black picture according to user-defined percentage
non-black picture, delay (duration), and black level
threshold values

VChip Data Missing

Indicates that there is no V-chip data in the
incoming video stream

VITC Missing Indicates that there is no VITC in the incoming
video stream
CC Not Valid Indicates that the closed captioning data in the

incoming video stream is not usable

Teletext Missing

Indicates that there is no teletext in the incoming
video stream

Teletext Not Updating

Indicates that the teletext data in the incoming video
stream is frozen

Teletext Not Valid

Indicates that the teletext data in the incoming video
stream is not usable

AFD Missing

Indicates that AFD data is not present in the
incoming video

AFD Format Change

Indicates that the AFD information has changed
from its previous format

Audio Format Change

Indicates that the audio format has switched from
Dolby D, Dolby E, or PCM, or indicates any format
change

Dolby E Program Change

Indicates that the Dolby program format has
deviated from the one specified

VChip Mismatch

Indicates that the V-chip data in the incoming video
stream does not match the expected rating

WSS Format Change

Indicates that the WSS information has changed
from its previous format

Multiviewer Module Parameters and Alarms

Multiviewer module parameters and alarms apply to the output module
hardware. To access the multiviewer module parameters and alarms, in the
Network view, click the CENTRIO module icon, and select either the
Parameters or Alarms tab. Table 2-5 lists the output module parameters and
Table 2-6 on page 44 lists the output module alarms.
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Table 2-5. Output Module Parameters

Parameter Name Function Options

Parameters

Module Type Displays the module type (displayed Master)
System Name Displays the name of the current output module (displayed system name)

Table 2-6. Output Module Alarms

Alarm Name Description

Major Alarm Summary Active if any alarm condition is reported
(priority > 7) for the module.

Minor Alarm Summary Active if any alarm condition is reported
(4 < priority < 7) for the module.

CPU Over Temperature The maximum operating temperature of the
module’s central processing unit has been
exceeded.

GPU Over Temperature The maximum operating temperature of the
module’s graphics processing unit has been
exceeded.

Main Board Over Temperature | The maximum operating temperature of the
module’s main circuit board has been exceeded.

Storage Over Temperature The maximum operating temperature of the
module’s storage device has been exceeded.
Fan Unit 1 Failure Cooling Fan Unit #1 is not operating.
Fan Unit 2 Failure Cooling Fan Unit #2 is not operating.
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Configuring Multiviewer Outputs

Use Layout Designer to select which outputs you want to use to display layouts.
You can access these options from the Advanced Configuration dialog box.

Use these controls to select whether to output layouts to DVI or SDI output
display devices. You cannot output layouts simultaneously to both DVI and SDI
outputs. You can select from the following output display options:

DVI  Displays redundant, different, or spanned layouts on one or two
monitors (options are displayed in Table 2-7)

SDI Displays redundant, different, or spanned layouts on up to four
monitors (options are displayed in Table 2-8 on page 46)

* Redundant mode—Displays copies of a single layout on more than one
output display device

* Independent mode—Displays a single layout on a output display device

» Spanned mode—Displays a single layout across two output display
devices
When you select spanned mode, you can also select either Horizontal or
Vertical as a display orientation.

Table 2-7. DVI Output Display Configurations
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Table 2-7. DVI Output Display Configurations (Continued)

Output Video Setting | Display
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Table 2-8. SDI Output Display Configurations
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Table 2-8. SDI Output Display Configurations (Continued)

Output Video : Output Video .
Setting Display Setting Display
Spanned SDI 3DI1 SDI2 Dual SDI
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Configuring Outputs With Layout Designer

You can use Layout Designer to select which outputs you want to use to display
layouts as well as select an Output Display mode for your output display
devices.

-
£ Note

You must be familiar with the operation of your Layout Designer software
application. For more information, see your Layout Designer Software
Application User Guide.

Before using Layout Designer to configure your outputs, you must perform the
following tasks:

» Install Layout Designer on a local or network PC (see your Layout Designer
Software Application User Guide)

* Add your multiviewer to a router database (see “Adding Multiviewers to a
Router Database” on page 20)

» Change the default IP address of your multiviewer (“Configuring
Multiviewers in a Local Area Network” on page 28)

o Discover your multiviewer output module (see “Discovering Output
Modules Using Layout Designer” on page 29)

To configure your outputs

1. Start Layout Designer.

If a message appears telling you that Layout Designer cannot connect to
your multiviewer, check your system Ethernet connection, and then
rediscover your multiviewer (see “Discovering Output Modules Using
Layout Designer” on page 29).

2. Inthe Multiviewer panel, right-click on a connected Harris multiviewer,
and then select Advanced Configuration from the context menu.

3. From the Advanced Configuration dialog box, click the Display tab.

Harris Multiviewer Installation, Configuration, and Operation Manual a7

Copyright © 2008-2009, Harris Corporation



Chapter 2: Configuration and Operation

4. Under Video Output, select SDI or DVI.

The row of options will update to reflect the monitor configurations that are
available (see Table 2-14 and Table 2-15).

Fov T so
(" Redundant DVI Spanned DVI (% Dual DVI " spanned DVI Vertical

" Quad DVI
(12}
(3 [a|

DV Resolution™ IIBSE % 1382 'l Frame Rate® |60 _¥|Hz

Figure 2-14. Selecting Video Output Settings for DVI

Video Qutput
Cpvi (¥ spI
" RedundantSDI ¢ Spanned DI Quad SDI ( Dual SDI
ESEN - ENEN x|
B EXER [ 2 |
=01 Standard | 10301 53,34 ~|

Figure 2-15. Selecting Video Output Settings for SDI

¥

£ Note
You cannot output layouts simultaneously to both DVI and SDI outputs.

5. If you selected a DVI video output setting, select an output resolution from
the DVI Resolution drop-down list. If you selected an SDI video output
setting, select an output resolution from the SDI Standard drop-down list.

6. Click Done.

For information on the Test Signal and Timing options on this screen, see your
Layout Designer Software Application User Guide.
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Configuring JLCooper eBOX in Layout Designer

You can use JLCooper eBOX units to add GPIO functionality to your Harris
multiviewer. For information on connecting a JLCooper eBOX, see “External
Hardware Components” on page 11 and the documentation that came with the
unit.

The first JLCooper eBOX that is connected to the multiviwer using Ethernet
must be set up as a server, and any following eBOX devices should be
configured as clients. Information on configuring clients and servers is included
in your JLCooper eBOX documentation.

To configure your multiviewer to communicate with the JLCooper eBOX,
follow these steps:

1.

Right-click a device in the Multiviewers window, select Advanced
Configuration, and then click on the External Devices tab.

(Optional) In the Name field, enter a name for the device.

Under Type, select JL Cooper E-Box.

Under Port, select TCP/IP.

The right side of the dialog box may update to display IP settings.
Under IP, enter the IP address of the JLCooper eBOX.

192.168.254.102 is the default IP address. Depending on the way your
eBOX is connected to the multiviewer, you may need to change this so both
devices are on the same subnet. This is not necessary if they are connected
directly using an Ethernet cross-over cable. See your eBOX Users Manual
for information on changing the device’s IP address.

Under IP, enter the IP Port of the JLCooper eBOX.

The default port is 23.

Click Add.

The JLCooper eBOX appears in the table below the Add button.
Click Done to close the Advanced Configuration dialog box.
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Configuring the Multiviewer to share JLCooper eBoxes

You can connect up to four eBoxes to a multiviewer output module, providing
up to 96 GPI/O triggers.

22| Advanced Configuration

Device Configuration

Device Namea
233-1
2341
250-1
245-1

1P: 192.168.100.101

Port: 23

Display 1P Settings Miscellansous
External Devices Version Source UMD NTP

Hame|

| MNama Type Fort Address IP Port Data Bits
| eBOX1 JL CooperE-Box  TCP/IF 15216810010 23
| eBOX2 JL CooperE-Box  TCP/F 182168100100 23

. eBOX1 =GPI/O 01~24

. eBOX2 = GPI/O 25~48

Figure 2-16. Connecting Multiple eBoxes to a Single Multiviewer

1. Configure a multiviewer to connect to multiple eBoxes, following the steps

in “Configuring JLCooper eBOX in Layout Designer” on page 49.

2. Configure a second multiviewer to connect to an eBox as in Step 1, with the
following changes:

» Use the IP address of the multiviewer configured in Step 1.
e Use IP port 49153.
3. To configure each additional multiviewer to connect to a multiviewer

configured with an eBox, increment the IP port number by one each time

(port 49154, 49155, and so on).

To configure eBox server port, edit the settings.xml eBoxServerPort on the

multiviewer that has the eBox physically connected.

Configuring Multiple Multiviewers to Multiple JLCooper eBoxes

You can connect multiple multiviewers to up to four JLCooper eBoxes.
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Note: The EBoxServerPort parameter in Settings.xml file defines the base
starting port number. This parameter setting is only applicable to the master
multiviewer.

IP: 192.168.100.101
Name Type Port Address 1P Fort Rort: 23 c

eBOX1 JL Cooper E-Box  TCPIIP 192.168.100.101 23 =

eBOX2 JL Cooper E-Box  TCPIIP 192168100102 23 f—

503 JU Cooper E-Box  TCPIP 1921681007103 23 !

IP: 192.168.100.102
Port: 23
¥

— ]

IP: 192.168.100.103
Port: 23

Name Type Fort Address 1P Port |
€B0X1wvia CENT JLCooperE-Box TCPIP  152.168100.11 49153 }
€B0X1via CENT JLCooperE-Box  TCPIP  152.168100.11 49154 e

8BOX1via CEN1  JL Cooper E-Box  TCPIP 152,163 100.11 49155

Multiviewer #3 (Slave) 19216810013

Do

*eBOX1=GPI/O 01~24
*eBOX2 = GPI/O 25~48
*eBOX3 = GPI/O 49~72
*eBOX4 = GPI/O 73~96 (Max)

Name Type Port Address 1P Port
e80X1via CENT  JLCocperE-Bex TCPIP  192.168.100.11 48153
e80X1via CENT  JLCocperE-Bex  TCPIP  192.168.100.11 48154
e80X1via CEN1  JLCooperE-8ox  TCPAP  192.168.100.11 49155

Figure 2-17. Multiple JLCooper eBoxes Connected to Multiple Multiviewer Devices

1. Onthe Advanced Configuration > Ext. Devices Tab, configure the master
multiviewer to point to all eBOXes using the port defined in the
EBoxServerPort parameter in the Settings.xml file.

The default is 23. In Figure 2-17, the master multiviewer points to three
eBoxes on port 23.

2. Onthe Advanced Configuration > Ext. Devices Tab, configure the slave
multiviewers to point to the master multiviewer using the starting port
number (port 49154, 49155, and so on).

The slave multiviewer’s port number automatically increments by one for
each eBOX configured.

Using the Multiviewer Control Panel

Administrator users of the multiviewer may need to use the Multiviewer
Control Panel to perform maintenance operations. To access the Multiviewer
Control Panel, you must exit the multiviewer from the On-Screen menu.
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Accessing the Multiviewer Control Panel

1. Select Exit Multiviewer from the On-Screen menu, and then click Yes to

confirm.

A dialog box similar to the following will appear. The Disable becomes
Enable, and all the buttons in the Actions section of the screen will be

unavailable.

EZMultiviewer Control Panel x|

—Maintenance Mode

Dizable

Statug ——————

—Actions

Stop Multiviewer

Device Manager

E =plorer

MDA Control
Farel

Command Prarmpt

Set Time / Date

Acquire Mew
Drizplay

Logz

Shutdawn Spetem

Restart System

Figure 2-18. Multiviewer Control Panel

2. Click Enable to enter Maintenance mode.

With Maintenance mode enabled, the following actions will be available:

Table 2-9. Multiviewer Control Panel Options

Button

Function

Enable
Disable

Sets the Control Panel to maintenance mode

Sets the Control Panel to normal operation mode (from
maintenance mode)

Stop/Start Multiviewer

Starts or stops the Multiviewer On-Screen Application

Explorer

Starts the file system explorer application

Command Prompt

Starts the command prompt application

Acquire New Display

Sets your multiviewer temporarily from SDI mode to DVI
mode for diagnostic purpposes (a restart is required);
restart the multiviewer again to return to SDI mode
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Table 2-9. Multiviewer Control Panel Options (Continued)

Button Function

Shutdown System Shuts down the output module (You will need to re-insert
the output module or repower the Platinum frame to
restart the multiviewer)

Device Manager Starts the device manager application

NVIDIA Control Panel Starts the NVIDIA application to configure the NVIDIA
graphics drivers settings

Set Time/Date Opens the Date and Time Properties dialog box
Logs Opens the Multiviewer Logs dialog box for viewing
Restart System Shuts down and restarts the output module

Starting the Multiviewer from the Multiviewer Control Panel
You can start the multiviewer from the Multiviewer Control Panel.

1. On the Multiviewer Control Panel, click Enable.

2. Click Start Multiviewer.

The Configuration dialog box appears.

i

—LD Proceszor Options

v Load last layout on startup

¥ Save source changes to layout

—Graphics Core Options
V¥ Force Display &dapter Settings
v Show Advanced FiP Information
™ Show CPU meter

[ Output to Window

Wafidth; |54|:| Height: |4BEI

— Systern Options

LTC Input Fermat |SMPTE 309 =]
Fevert Apply
Cancel | Launch Multivigwer

Figure 2-19. Configuration Dialog Box
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Table 2-10. Configuration Dialog Box Options

Option

Function

Load last layout on
startup

When this is checked and the multiviewer starts up, it will reload
the layout that was displayed when you last exited

Save source changes
to layout

When this is checked, after you change inputs to the PiPs (for
example using CCS controls or NUCLEUS), these changes are
saved to the layout, and are reloaded if the layout is loaded
again.

When this is not checked and you make changes to the layout,
when the layout is reloaded, it will revert to its original inputs.

Force Display
Adapter Settings

This option should always be checked during normal operation.
When it is not checked, the display settings may not be respected
by the display device.

Show Advanced PiP
Information

This is normally used for diagnostic purposes, and includes the
XVIM ID that PiPs are coming from, and their input source

Show CPU Meter

Shows the percentage of the CPU power that is currently in use;
this option is normally not checked

Output to Window

Outputs the layout configuration to a window (as defined by the
Height and Width fields) on your screen; this option is normally
not checked

LTC Input Format

Used when configuring the clock reference signal; options
include:

e Leitch 12M
« SMPTE 12M
« SMPTE 309

3. Click Launch Multiviewer to start the Multiviewer application and its

On-Screen menu.

Click Apply to save your System Startup settings, Revert to reset the
content of the Configuration dialog box, or Cancel to cancel launching the
Multiviewer application.

Restarting the Multiviewer Control Panel

If you accidentally closed the Multiviewer Control Panel, you can reopen it.
1. Simultaneously press the CTRL, ALT, and DEL keys on your keyboard.
The Windows Security dialog box opens.
Select Task Manager.
The Windows Task Manager dialog box opens.
From the application menu, select File > New Task (Run)...
A Create New Task dialog box opens.
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5. Click Browse, and navigate to C: > Program Files > Harris > Harris
Multiviewer.

6. Double-click on XenaShell.exe, and then click OK.
The Multiviewer Control Panel appears.

Unlocking the Multiviewer Display
If you accidentally locked the Multiviewer display, you can unlock it.
1. Inthe Unlock Computer dialog box, enter the following settings:
» User Name: Administrator
e Password: (your Multiviewer Administrator user password)

By default, this password is set to Centrio. Note that these fields are
case sensitive.

2. Click OK.
)
2 Note

Changing the password is not recommended. If you change the password,
you will be prompted to enter it every time the multiviewer is restarted.

Configuring Multiviewers for Router Follow

With destination router follow, you can configure a PiP to follow a particular
destination within the router database.

Configuring Specific PiPs for Router Follow
1. In Layout Designer, open an existing layout, or create a new layout.
2. Select a PiP in the layout that you want to router follow.

3. Check Follow Destination in the PIPs properties tab, and then in the field
to the right, enter the number of the router destination for the PIP to follow.

4. (Optional) Check the box beside Virtual for virtual destinations.

Virtual outputs need to exist in the router database. See “Configuring
Virtual Destinations for Router Follow in a Router Database” on page 55.

Configuring Virtual Destinations for Router Follow in a Router Database
To add virtual destinations to a router matrix, follow these steps:
1. In Navigator, double-click the Frame in the Routers folder.
The Edit Platinum Frame dialog box appears.

2. On the Configured Matrices tab, select the matrix to add the virtual output
module(s).

3. Right-click an empty output location in the frame and select Assign to.

You can add outputs that are not physically present in the frame, for example

destinations numbered higher than the number of actual destinations in the
matrix.

Harris Multiviewer Installation, Configuration, and Operation Manual 55
Copyright © 2008-2009, Harris Corporation



Chapter 2: Configuration and Operation

Tieline Support

To enable support for tielines in the Harris Multiviewer, follow these steps:

1.

4.

Open the settings.xml file in C:\Program Files\Harris\Harris
Multiviewer directory.

Find the following line:
<enableRemoteSources>false</enableRemoteSources>
Edit this line from false to true as follows:
<enableRemoteSources>true</enableRemoteSources>
Save the change and restart the Harris Multiviewer.

This change will allow the Harris Multiviewer access to tieline sources from
upstream routers. These sources can now be assigned to PIPs in Harris Layout
Designer or in the Select Video Source option of the On-Screen Menu.
Alternatively, PIPs can be configured for destination follow and the tieline
sources assigned through an external control panel.

If there are no tielines available, the PIP will show one of the following:

If the tieline sources are assigned to the PIP through Layout Designer or
switched using the on-screen menu, then a "No Signal" message will appear
on the PIP.

If the PIP is configured for destination follow and routed to a tieline source,
then the PIP will keep the signal that was present before the route request to
the new tieline source.
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Installing and Connecting Overview

The output modules are installed in the output section of Platinum router
frames. Each output module occupies four output slots in the router frame.
Since the output module is shipped as a complete “solid-state” unit, you do not
need to install individual components.

Warning

Potentially lethal voltages are present within the Platinum frame during
normal operation. Disconnect all power cords from the frame before you
remove the top panel. Do not apply power to the frame while the top is open
unless the unit is being serviced by properly trained personnel.

Output modules are hot-swappable, and they do not need to be installed next to
each other. However, keep in mind that the slots you select to install the
multiviewer may affect how efficiently you can populate other output slots in
the router.

ACaution

We recommend that you test your system before its final installation. Make
sure that you verify its configuration, cabling, and proper system operation.
Observe proper anti-static and grounding procedures while handling loose
boards and servicing equipment.
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Video inputs are routed from Platinum crosspoint modules to the inputs of the
output module. The number of multiviewer modules that you can install in a
Platinum router is determined by the size of the router frame. Table 3-1 lists the
number of supported output modules that can be installed in 9RU, 15RU, and
28RU Platinum router frames.

~¥
£ Note

Your sales representative can tell you whether you have sufficient power
supplies installed in the frame to power the installed modules.

Table 3-1. Number of Installed Output Modules in Platinum Frames

E:gtri]neum mg)t(éllll\lelfijbL?trp?th Number of Input | Number of DVI Number of SDI
Size Modules Channels Outputs Outputs

9RU 4 128 8 16

15RU 8 256 16 32

28RU 16 512 32 64

Table 3-2 provides information about the number of embedded, discrete analog,
and discrete AES audio inputs that are supported when the multiviewer is

installed in 9RU, 15RU, and 28RU Platinum frames.

Table 3-2. Audio Configurations

Audio Input Type

9RU (16 Slots)

15RU (32 Slots)

28RU (64 Slots)

Embedded Channels

128 per module
2048 per frame

128 per module
4096 per frame

128 per module
8192 per frame

Discrete Analog
(stereo/mono)

16/32 per module
256/512 per frame

16/32 per module
512/1024 per frame

16/32 per module
1024/2048 per frame

Discrete AES
(balanced/unbalanced)

16 per module
256 per frame

16 per module
512 per frame

16 per module
1024 per frame
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Figure 3-1 illustrates two output modules installed in a 15RU Platinum router
frame.

Qutput signals to
autput display
devices .\-
Router input signals
Input modules
Multiviewer
output modules
Cutput modules
Crosspoint modules
128=256)

Figure 3-1. Platinum 15RU Router Frame with Output Modules

Check the release notes for your devices to determine compatibility between
diffferent hardware and software versions, in particular the multiviewer module
and PT-RES module versions.
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Installing Multiviewer Hardware

The following sections describe how to install back modules and output
modules in Platinum router frames. Output modules can be installed without
powering down your Platinum router frame.

Installing the Back Module

A back module takes up four slots in the output section of your Platinum router
frame.

1. Remove any currently installed Platinum output back modules from the
appropriate four slots (per output module) where you want to install the
back module.

2. Remove the blank covers or output module back connector of the

appropriate four slots (per output module) on the rear of the Platinum frame
(a #1 Phillips-head screwdriver is required).

3. Carefully align and then attach the back module over the empty slots using
the captive screws. Do not discard the screws, as you will need them again.

-
£ Note

Do not tighten down the screws completely when installing the back
module. First, install the output module, and then tighten the back module
screws.

Installing the Output Module

ACaution

Before you install the output module, ensure you properly align the module
with the appropriate guide notches in the router frame. Failure to do so may
damage the pin connections between the back and output modules.

1. If you have not done so already, remove any currently installed Platinum
output modules from the appropriate four slots (per output module) where
you want to install the output module.

2. Open the 1/O Guide door.
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3. Align the installation guides on the left and right sides of the back module
with the guide notches of the appropriate slots in the Platinum frame (see
Figure 3-2).

Guide notches on Platinum frame

\ Extractor handle
Fan unit 2

Fan unit 1

o

ccoeeo0 B0 Bl B

Output module installation guides

Figure 3-2. Installing the Output Module

4. Pull and hold the back module’s extractor handle, and then slide the back
module assembly into the frame until it is fully seated.

Let go of the extractor handle and push it into the locking position.
Close the I/O Guide door.
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Making System Connections

The following sections provide information about making output module
connections, including the following:

Ethernet connections for CCS/router network and Layout Designer
DVI and SDI output display devices

Audio monitoring devices

Serial breakout cable

Ethernet connections to third-party GPI 1/O hardware interface
LTC connections

Securing Your Device Cabling

ACaution

When making connections from external devices to the multiviewer, it is
important to properly secure the cables to your equipment rack. Use cable
ties to secure the various device cables to your equipment rack so that the
rack supports the weight of the cables. Failure to do so will cause excessive
weight on the back module and breakout module connections and
connector pins, which may permanently damage your system.

Network Connections

Harris multiviewers have two Ethernet connections that allow you to connect
directly to a local PC running Layout Designer software or to CCS network.
When the multiviewer is connected to a CCS network, you can use CCS control
options such as CCS Navigator and NUCLEUS.
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Connecting Output Display Devices

The Multiviewer’s back module provides two DVI and four HD/SD-SDI output
connections. You must configure the multiviewer to display either two DVI or
four SDI outputs. You cannot send layouts to the DVI and SDI outputs
simultaneously.

—_—

.s:-"dg Note

The DVI connectors labeled DVI 3 and DVI 4 on the back module are for
future use.

SDI Outputs 1 and 2
|

SDI Outpluts 3and 4

Figure 3-3. SDI Output Connectors
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Table 3-3 lists the output display resolutions supported by the Harris
multiviewer’s DVI and HD-SDI outputs.

Table 3-3. Supported Output Resolutions

HD-SDI and SD-SDI

H 1
DVI Output Resolution Output Resolution

When Redundant DVI, spanned DVI, Dual DVI, or | * 1080i @ 50 Hz
Spanned Vertical DVI is chosen . 1080i @ 59.94 Hz

+ 1024 x 768 * 1440 x 900 . 720p @ 50 Hz

« 1024 x 800 « 1440 x 1080 . 720p @ 59.94 Hz
« 1152 x 864 + 1600 x 900 . SD 5255094

« 1280 x 720 « 1600 x 1024 . SD 62550

« 1280 x 768 + 1600 x 1200

« 1280 x 800 « 1680 x 1050

+ 1280 x 960 - 1792 x 1344

« 1280 x1024 - 1856 x 1392

« 1344 x 840 * 1920 x 1080

« 1440 x 1050 « 1920 x 1200

e 1400 x 1050
When Quad DVI is chosen
e 1280 % 720
e 1024 x 768
e 1440 x 900
e 1280 x 1024

LFor these resolutions, the multiviewer hardware supports both 50 Hz and 60 Hz
output.

¥
£ Note
Supported DVI output resolutions are subject to the capabilities of the
connected DVI display. Support cannot be guaranteed for displays with
non-standard timing.
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Output Display Modes

You can operate the multiviewer in either Redundant, Independent, or Spanning
mode. You can select the display mode for your output module using Layout
Designer. See the Multiviewers Configuration chapter in your Layout Designer
Software Application User Guide.

Redundant mode - Displays the same layout on each output. By default,
your output module is set to Redundant mode.

Independent mode - Displays a different layout on each output. When
using this mode, each output can be configured for different format, aspect
ratio, and orientation.

Spanning Mode - Displays (or spans) one layout across outputs. When
using this mode, each output must be configured for the same format, aspect
ratio, and orientation.

Connecting DVI Display Devices to the Multiviewer

Depending on your output display device and the type of DVI output you are
using, use the following DVI cabling guides:

Standard DVI-I1 digital/analog cable - Use this cable when outputting to a
PC digital (DVI) and analog (VGA) video monitor. This cable has a 29-pin
DVI/VGA combined receptacle connector.

Standard DVI-D digital-only cable - Use this cable when outputting
digital (DVI) video signals only. This cable has a 19-pin DVI-D digital-only
receptacle connector (no key slot on left side of connector)

VGA cable with VGA-DVI adaptor, or DVI-A cable with DVI-VGA
adaptor - Use this cable when outputting analog (VGA) video signals
only. This cable has a 17-pin connector that requires an appropriate adaptor
and corresponding cable.

Connecting HDTV Display Devices to the Multiviewer

The multiviewer’s back module provides four BNCs per IEC 169-8 for
connecting to HD-SDI monitors. For specification information, see “HD-SDI
Outputs” on page 73.
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Connecting Output Audio Monitoring Devices

Use the back module’s two digital audio monitoring outputs to connect
compliant audio monitoring devices, for driving devices such as speakers or
headphones, to the multiviewer. This allows audible monitoring of audio
sources for any two program signals that are currently being monitored by the
multiviewer. Selection of channels to monitor can be chosen from a single
stereo pair, or any two mono channels associated with the specific program
signal.

Standard coaxial/unbalanced
output audio connectors

Figure 3-4. AES Audio Outputs (Standard Coaxial/Unbalanced)

For audible monitoring, the program signals must be routed to one of the
displays associated with the multiviewer. You can use Navigator or NUCLEUS
Control Panel to route these signals. See “Multiviewer System Parameters and
Alarms” on page 39 or your NUCLEUS CENTRIO Control Option
Configuration and Operation Manual for more information.

Connecting Devices to the Serial Connection

The serial breakout cable expands the back module’s serial inputs from one
DB-26 connector into four separate DB-9 pin connectors each representing a
serial port. These serial ports can be used for applications such as the following:

» Connecting your multiviewer to external UMD devices
» Facilitating a Harris snoop application
» Providing EAS alert data from TFT and Sage boxes
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Table 3-4 provides connection and configuration information about each serial

port.

Table 3-4. Multiviewer Serial Breakout Cable Information

Serial Port ; Supported

Number Connector | User-Configurable Protocols

1 DB 9 (male) | Yes » RS-232
e RS-422
¢ RS-485

2 DB 9 (male) | Yes * RS-232
e RS-422
¢ RS-485

3 DB 9 (male) | No RS-232

4 DB 9 (male) | No RS-232

%
< Note

Serial Ports 1 and 2 can have a software-selectable termination enabled on

each receiver's port. The termination resistor value is 120Q. This is most

often used in RS-422 point-to-point connections. In the case of RS-485, if
the multiviewer unit is at the end of the RS-485 bus, this termination can be
activated to terminate the bus.

Table 3-5 provides pinout information for the serial breakout cable’s DB-26 and
each DB-9 connector.

Table 3-5. Serial Breakout Cable Pinouts

8T | ToT | YoB | "o | YoB
2 S8 282 P82 | 282 peccription

Pin Pin Pin Pin Pin

Number Number Number |Number |Number

1 1 Ground

3 2 RS-232 RX or RS-422/485 TX-

19 3 RS-232 TX or RS-422/485 RX+

4 4 Ground

5 5 Ground

6 6 Ground

2 7 RS-422/485 TX+

20 8 RS-422/485 RX-

9 9 Ground

18 1 Ground

7 2 RS-232 RX or RS-422/485 TX-
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Table 3-5. Serial Breakout Cable Pinouts (Continued)

8T | “of Yo “eT | IoB
22 882 82 P82 | 8282 peccription

Pin Pin Pin Pin Pin

Number Number Number |Number |Number

21 3 RS-232 TX or RS-422/485 RX+

14 4 Ground

13 5 Ground

12 6 Ground

8 7 RS-422/485 TX+

22 8 RS-422/485 RX-

11 9 Ground

23 2 RX (RS-232)

24 3 TX (RS-232)

16 5 Ground

15 9 Ground

26 2 RX (RS-232)

25 3 TX (RS-232)

17 5 Ground

10 9 Ground

Connecting JLCooper eBOX Devices

Harris multiviewer systems are designed to work with JLCooper eBOX Quad
Serial to Ethernet Interface. You can control up to 24 GPI input and 24 GPI
output devices per eBOX. The multiviewer communicates with eBOX through
one of the output module’s Ethernet connections. To connect the eBOX to an
output module, both the multiviewer and JLCooper eBOX must be on the same
network and able to communicate with each other. See “Configuring
Multiviewers in a Local Area Network” on page 28 for more information.

Extra serial ports available:
e 4x 9-Pin D Sub Serial Connectors
e 2% 25 Pin D Sub GPI Connectors

The GPI In connector has 24 TTL/CMOS compatible inputs with internal
pull-ups to +5 volts. The GPI Out connector has 24 TTL/CMOS compatible
outputs. On both connectors, pin 1 is the ground reference and pins 2-25 are GPI
signals 1-24. The eBOX also has an ¢ RJ-45 Ethernet Connector for LAN, WAN
or Internet Control.
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The eBOX must be set as a server only, and only a single multiviewer can be
connected to each eBOX link. The master/slave function allows UMD-tally data
to go through the master multiviewer without external wiring.

To configure the eBOX, follow these steps:

1. Set SW8 to the ON position, and then re-power to access the Configuration
Web Server for the eBOX.

Set SW1, SW2, and SW3 to the DOWN position, and then re-power.

Using an external PC (on the same sub-network), launch a Web Browser
and type the IP Address of the eBOX.

ACaution

Do not use Internet Explorer 7 or Firefox web browser to change he network
settings on the eBOX. Internet Explorer 6 is the only authorized application
for getting into the built-in Web Server to change the network settings.

The eBOX’s default IP address is 192.168.254.102.

Pramary Setup information
192 1B ] (254 iz (Device IP Address)
2hh 255 |.|256 |0 (Subnet Mask)
192 1B [ 2% | 1% |(Gateway Address)
00023 (Pett Number)

Figure 3-5. eBOX Web Interface

4. Make the necessary Network changes and setup Port # 23.
5. Remove any Password, and then press the SUBMIT button.
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6. Set SW1, SW2, SW3, and SW6 to the ON position, and set SW7 and SW8
to the OFF position.

e

1 2 3 4 5 6 7 8

Figure 3-6. eBOX Dip Switch Settings for Operation

7. Re-power the unit.
8. Ping to confirm the new Network setting.

For information about configuring your e-BOX, see your JLCooper eBOX
documentation.

Connecting a Linear Timecode Input Reference Signal

You can input balanced linear timecode (LTC) from a time reference source.
The LTC input signal can be used as a time reference for on-screen clocks and
counters that are displayed in multiviewer layouts. Using Layout Designer, you
can also configure offsets for the LTC input signals.

Harris Multiviewer supports the following timecode formats:
e Leitch 12

 SMPTE 12M

 SMPTE 309 M

Figure 3-7 illustrates the LTC input with pin information.

LTC
IN

Positiv: Ground Negative

Figure 3-7. LTC Input Pin Information

Connecting Matrox TripleHead2Go For Quad DVI Mode

In order to output to four monitors at once (Quad DVI mode), you must have
two Matrox TripleHead2Go devices, one connected to DVI Output 1, and the
other connected to DVI Ouput 2, using a Dual link DVI-D cable.

TripleHead2Go setup information is provided in a separate document. Please
contact Customer Service for complete installation instructions.
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Matrox TripleHead2Go devices require the latest firmware to operate correctly
with a multiviewer system. If Matrox TripleHead2Go devices are received from
our factory, then they will have been updated with the latest firmware.

? Note

Do not use DVI outputs 3 and 4. These outputs are reserved for future use.

DVI Outputs 1 and 2
I

Figure 3-8. DVI Outputs 1 and 2

To connect the Matrox TripleHead2Go devices for operation with the Harris
multiviewer, follow these steps:

1. Shut down the Harris multiviewer.

2. Connect the DVI and USB cables from the Matrox TripleHead2Go device
to as in Figure 3-9.

DVl output 1 Output 1 |:|
j USB cable Matrox device | Joutput 2 (capped) |:|
|

Output 3

Harris multiviewer

5 DVI output 2 Output 1 |:|
—  USB cable Matrox device | ] Output 2 (capped) |:|
i

Output 3

Figure 3-9. Connecting Matrox TripleHead2Go Boxes

3. Connect the monitors to the Matrox TripleHead2Go boxes to output 1 and
output 3 on the TripleHead2Go device.

Output 2 should remain capped, since this output is not used.
4. Start the multiviewer.

The LED above the lightbulb symbol on the Matrox TripleHead2Go
devices should be green when in normal operation.
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Specifications

Linear Time Code Input

Table 4-1. Balanced Longitudinal Time Code

Item

Specification

Standards (compatible)

* SMPTE 12M-1999
* SMPTE 266M-2002

Connector type

3-pin LTC

Impedance

Hi-Z (>30 kQ)

Input sensitivity

100 mV pk-to-pk

HD-SDI Outputs

Table 4-2. Layout Designer HD-SDI Output Specifications

Item

Specification

Number of outputs

4

Standards (compatible)

* SMPTE 259M
* SMPTE 292M
* SMPTE 424M

Frame rates - 1080i50

» 1080i59.9

* 720p50

e 720p59.9
Connector type BNC per IEC 169-8
Impedance 75Q
Return loss >15 dB (typical) to 1.485 GHz
DC offset 0.0Vz05V
Signal level 800 mV £ 10%
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Table 4-2. Layout Designer HD-SDI Output Specifications

ltem Specification
Rise and fall time <270 ps at 1.485 GHz
Overshoot <10% of amplitude
Jitter e Timing (<1 Ul at 1.485 GHz)
e Alignment (<0.2 Ul at 1.485 GHz)
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Supported Video Output Resolutions

*
2 Note

Supported DVI output resolutions are subject to the capabilities of the
connected DVI display. Support cannot be guaranteed for displays with
non-standard timing..

Table 4-3. Supported Output Resolutions

DVI Output Resolution! SDI Standard

When Redundant DVI, spanned DVI, Dual DVI, or | * 1080i @ 50 Hz
Spanned Vertical DVI is chosen . 1080i @ 59.94 Hz

+ 1024 x 768 « 1440 x 900 . 720p @ 50 Hz

+ 1024 x 800 « 1440 x 1080 . 720p @ 59.94 Hz
« 1152 x 864 « 1600 x 900 . SD 5255094

« 1280 x 720 « 1600 x 1024 . SD 62550

« 1280 x 768 « 1600 x 1200

+ 1280 x 800 « 1680 x 1050

« 1280 x 960 . 1792 x 1344

« 1280 x1024 - 1856 x 1392

* 1344 x 840 « 1920 x 1080

« 1440 x 1050 * 1920 x 1200

» 1400 x 1050
When Quad DVIis chosen
e 1280 %720
e 1024 x 768
e 1440 x 900
e 1280 x 1024

$
& Note

1For these resolutions, the multiviewer hardware supports both 50 Hz and
60 Hz output.
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AES Monitoring Output

Table 4-4. Layout Designer AES Monitoring Output Specifications

DVI Qutputs

USB 1/O

Item Specification
Standards AES3, SMPTE 276
Type Unbalanced, AC coupled
Connector BNC (IEC169-8)
Impedance 75Q

Return loss >25dB, 0.1 to 6 MHz

Signal amplitude

1.0 V pk-to-pk +10% into 75Q load

Audio rate 48 kHz (fixed)

Jitter 20 ns

Rise/fall time 30 ns to 44 ns (10% to 90%)
Bits 24

Table 4-5. DVI Output Specifications

Item Specification

Standards DVI 1.0

Type DVI-I

Impedance 50Q

Amplitude 400 mV < Vswing < 600 mV (single-ended)
Rise/fall time 75 ps < Risetime/Falltime < 0.4 Thit

Jitter 0.25 Thit

Table 4-6. USB I/O Specification

Item Specification
Standard USB 2.0
Type A
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Ethernet I/O

Table 4-7. Ethernet I/O Specification

Item Specification
Standard IEEE 802.1
Type RJ45

Serial Ports

Table 4-8. Serial Ports Specification

Item Specification
Standard » RS-232 (TIA-232-F)
* ANSI/TIA/EIA-422-B
» EIA-485
Type DB-26 to DB9 breakout cable
Ports Ports 1 & 2 - 232/422/485 switchable
Termination Ports 1 & 2: Optional internal termination
is software-configurable
Ports 3 & 4: 232

Power Consumption

Table 4-9. Layout Designer Power Consumption Specifications

Item Specification
Input power 250 W max from Platinum frame power
supply
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Operating Temperature

Table 4-10. Operating Temperature Specification

ltem Specification

Operating Temperature 41° to 113°F (5° to 45°C).

Propagation Delay

Table 4-11. Propagation Delay Specification

Item Specification
Video delay 2 video frames/fields for DVI outputs
3 video frames/fields for SDI outputs
Audio delay matching video delay
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Frequently Asked Questions

Overview

This chapter answers frequently asked questions (FAQs) and provides
troubleshooting information about your Harris multiviewer system. The FAQs
are organized into the following categories:

»  System FAQs answers some common guestions about your multiviewer.
See “System FAQs” on page 79.

* Video input and output display FAQs answer some common questions
about video signals and display devices, as well as provide troubleshooting
information about display devices. “Video Input/Output Signals and
Display Devices FAQs” on page 80.

» CCS software FAQs answers common questions about using CCS software
applications with your multiviewer.“CCS Software Applications FAQs” on
page 81.

System FAQs

What are FPGA Errors?

FPGA errors indicate a power-up initialization failure. Immediately after a
power-on reset, a CPLD downloads firmware into programmable logic devices
(known as FPGAS).

If an initialization fails, an LED on the affected x\VIM module will light up (red)
to indicate that the XVIM FPGAs are not configured. If this error occurred after
a firmware upgrade, try running the upgrade again.

What Is the Typical Video Delay of a Harris Multiviewer Unit?

The video delay is two frames/fields in DVI output mode, and three
frames/fields in SDI output mode.
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Video Input/Output Signals and Display Devices FAQs

Why Does the External Display Attached to the VGA/DVI Output Have Poor Image Quality?

Most display problems can be traced to output display scaling artifacts or poor

cabling. Correcting these errors usually requires either configuration changes or
higher quality VGA/DVI cables. If the picture has lots of speckles or mosquito

noise, then the DVI cable is too long.

What are “Scaling Artifacts”?

Scaling errors can occur when a display device connected to a display output is
forced to rescale an image by interpolating new pixels. This rescaling occurs
because the display resolution generated by the output does not match the native
display resolution supported by the display device. The interpolation process
often introduces “scaling artifacts” that will soften or degrade the resultant
displayed image.

To avoid scaling errors, check the native resolution of the display device, and
wherever possible, configure the output to match the display’s native resolution.

What is “Ghosting”?

“Ghosting” refers to vertical fringing artifacts. The use of incorrectly specified
VGA cable or twisted pair connections most often causes this problem. Always
use high-quality, RF-screened VGA cable with individual coaxial cables for
each of the red, green, and blue signals of the VGA output.

What Calibration Adjustments are Necessary on the Attached Display?

To ensure a high-quality picture, you should always properly calibrate the
attached display device, particularly digital display devices such as plasma
displays and LCDs.

If the Output Signal Fails, What Should Be Done?
Check the following:

e There is power to the output module and it is turned on (the On LED is
green)

*  One or more valid input signal(s) are connected and the chosen PiPs or tiles
correspond to valid input(s)

» If you are using SDI, make sure you are connected to HD monitors

» If the VGA output is used, make sure that the VGA monitor is capable of
locking to the vertical scanning rate (50 Hz in 625 or PAL, 60 Hz in 525 or
NTSC); use high-quality, RFI-screened, multiple 75Q coax

» Ifyou are using two DVI displays, make sure they are connected to displays
of the same resolution, with the same vertical scanning rates

Why Do Some Video Tiles Appear to Have an Incorrect Format?

Ensure that the output line standard is selected to be the same as the majority of
the inputs.
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Check to see if you have selected the correct aspect ratio setting in Layout
Designer.

Why Do Moving Images Jitter in Some Video Tiles?

This occurs when the total resources required to display layouts selected on all
displays exceeds the defined system limitations. Review the used layouts and
ensure they are withtin the capabilities of your multiviewer configuration.

Why Does the Checker Board Test Pattern Not Look Right on a Plasma Monitor?

The checker board test pattern is used to calibrate the display for correct
sampling frequency and phase.

If the multiviewer is not set to the native resolution of the plasma display and a
checker board test pattern is selected, the displayed result will either be a
uniform grey field or a series of vertical and or horizontal interference fringes
visible across the display.

What UMD/Tally protocols are supported by Harris Multiviewers?

The Harris multiviewer supports the TSL protocol, Ross Tally, and a core subset
of the Image Video protocol (not full protocol) on TCP/IP.

CCS Software Applications FAQs

Is There a Specific CCS Application Version That | Need to Install?

Navigator 4.1 or later, and NUCLEUS 1.8 or later can be used with Harris
multiviewer.
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Servicing Instructions

Overview
ACaution
These servicing instructions are for use by qualified personnel only. To
reduce the risk of electric shock, do not perform any servicing other than
that contained in the operating instructions unless you are qualified to do
SO.
When servicing your Harris Multiviewer system, ensure that you take
precautions to prevent electrostatic discharge (ESD). See “Appendix A: Safety
Precautions, Certifications, and Compliances” in your Platinum Installation,
Configuration, and Operation Manual for more information.
These servicing instructions contain the following information:
» “Battery Use Warning” on page 84
e “Changing the Battery” on page 85
» “Discarding the Used Battery” on page 85
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Battery Use Warning

If you need to replace the CR2032 battery in your Multiviewer, heed this
caution:

AWarning

Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type.

[FI Finland] VAROITUS: Paristo voi rajahtaa, jos se on virheellisesti asennettu.
Vaihda paristo ainoastaan valmistajan suosittelemaan tyyppun. Havita kaytetty
paristo valmistajan ohjeiden mukaisesti.

[SE Sweden] VARNING: Explosionsfara vid felaktigt batteribyte. Anvand

samma batterityp eller en eller en ekvivalent typ som rekommenderas av
tillverkaren. Kassera anvant batteri enligt fabrikantens instruktion.

[D Denmark]

Advarsel! Lithiumbatteri. Eksplosionsfare ved fejlagtig
handtering. Udskiftning ma kun ske med batteri af samme
fabrikat oq type. Lever det brugte batteri tilbage till
leverandoren.

[KO Korean]

rEnl

grof B2l ©x|2 nE e 39, SHIE&40| 7tsELC
S& & TRlet nASt=RE MEUAE HYEUCH
AEE FMXlE HE FAHALR.
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Changing the Battery

Your output module has a CR2032 battery that may require replacement during
the product’s lifetime. The battery allows the multiviewer to maintain some
parameter options while it is powered down. Failure to replace the battery might
lead to some parameters resetting to default factory values when the system is
powered down.

To change this battery:
1. Remove the output module from the Platinum frame.

2. Using a small tool like a flathead screwdriver or pen, gently push the
metallic tab on the left corner of the battery.

An outward push on this metal tab will release the battery from its casing.
3. Remove the battery.

Push the tab
ently away from ~pm DEEEE TR

the battery [ \r

"

\_-_:.

Figure B-1. Battery Location Within its Casing

4. Replace the battery sliding the replacement battery into its casing.
5. Reinstall the output module in the Platinum frame.

Discarding the Used Battery

Dispose of batteries in a safe and proper manner in accordance with local
regulations. Refer to the packaging instructions that accompany your
replacement battery for more information.
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UMD/Tally Option

The Harris multiviewer offers optional under monitor display (UMD) support.
This option provides a protocol interface (via RS-232, RS-422, RS-485, or
TCP/IP) to different third-party UMD/tally generator systems in order to
display UMD source identification and tally status information. This
information automatically updates on-screen when it is changed by the tally
system.

Requirements for Optional UMD Support

The following items and installations are required to implement UMD support:

* Adevice that can generate UMD/Tally commands, for example, a UMD
generator, production switcher, or router. The Harris multiviewer supports
the TSL protocol, Ross protocol (, D-Series protocol, and a core subset of
the Image Video protocol (not full protocol) on TCP/IP.

*  One of the following cable connection options:

» RS-485 cable connection between a multiviewer (COM 1-4) and a
UMD/tally device (see Figure C-1 on page 88 and Figure C-2 on
page 89)

» RS-422 cable connection between a multiviewer (COM 1-4) and a
UMD/tally device (see Figure C-3 on page 90)

» RS-232 cable connection between a multiviewer (COM 1-4) and a
UMD/tally device (see Figure C-4 on page 90)

*  TCP/IP connection between a multiviewer and a UMD/tally device
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Sample System Configurations

This section illustrates some typical multiviewer to UMD device connections.
Figure C-1 illustrates a simplified system configuration with UMD/tally

support.
Note: A 120 ohm o
termination resistor is ~— =
located at each receiver at T T~ x| -
the ends of the bus. An X+
external termination RX—]|
resistor is not required. .
Multiviewer
1 -
& z Slave
By default, multiviewer’'s
RX+/- inputs are terminated.
=
Z
——— ] .
TX 4]
RX—
120 ohms Multiviewer
0
Disable the termination &+ & Slave
resistor on this multiviewer-> Terminatiop € OFF R
L]
[ L]
-
z
x| =
TX+]
—— Rx
120 ohms Multiviewer
# =
z
Disable the termination & L w Slave
resistor on this multiviewer-> WF
L
i = =
Tx. & £
T AR
RX—_1
T UMD/tally
120 ohms generator
L = =
By default multiviewer's rem-on § & | 2 F Master
RX+/- inputs are terminated. L
UMD/tally generator = Tallyman TMC-1
Typical RS-485 Four Wire Multidrop Configuration

Figure C-1. Typical RS-485 Four Wire Multidrop Configuration
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Note: A 120 Ohm
termination resistor is
located at each receiver at
the ends of the bus. An
external termination
resistor is not required.

By default multiviewer’'s
RX+/- inputs are terminated.

Disable the termination
resistor on this multiviewer -

Disable the termination
resistor on this multiviewer 2>

By default multiviewer's RX+/-
inputs are terminated.

Typical RS-485 Two Wire Multidrop Configuration
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— | & —
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[
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s 2 )
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& E
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— T A o —
—— TXi(\ (.
L i
— RX——\_;/O
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Multiviewer

Slave

Multiviewer

Slave

Multiviewer

Slave

UMD/tally
generator

Master

UMD/tally generator = Tallyman TMC-1

Figure C-2. Typical RS-485 Two Wire Multidrop Configuration
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Note: a 120 ohm
termination resistor is
located at each receiver at
the ends of the bus. An
external termination
resistor is not required.

By default multiviewer's RX+/-
inputs are terminated.

i = =
\ T)( tzh z
— s T
RX——_|
120 ohms Multiviewer
U 0
&z z Slave
= =
z 4
x| @ =
x|
RX——|
h X UMD/Tally
120 ohms Generator
1 = =
Temninaon = ON & g 4 Master
UMD/Tally generator = Tallyman TMC-1

Typical RS-422 Point-to-Point Configuration

Figure C-3. Typical RS-422 Point-to-Point Configuration

By default multiviewer's RX+/-
inputs are terminated .

Disable the termination resistor
on this multiviewer >

= =
z z
& Z
— RX:
TV
] GND Multiviewer
) =
3 G Slave
2 2
4 4
& Z
R
i UMDftally
GND generator
2 =2
3 & Master
UMD/Tally Generator = Tallyman TMC-1
Typical RS-232 Point-to-Point Configuration

Figure C-4. Typical RS-232 Point-to-Point Configuration

Configuring TSL ASCII UMD Protocol

TSL UMD protocol is configured in the External Communication tab of
Layout Designer’s Advanced Configuration dialog box.

1. Under Type, choose TSL Protocol.
2. Under Port, choose the COM Port that TSL communication will be

received through.
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3. Under COM, make the following selections:
» Baud rate: 38400 bits/second
» Data bits: 8
* Parity: even
o Stop (bits): 1
4. Click Add.

Configuring Image Video UMD Protocol

The harris multiviewer supports a core subset of the Image Video Protocol. The
TSI-1000 Image Video Tally Controller collects information from signal routing
and processing equipment to operate displays and tallies as directed by its
internal configuration information.

To activate this option, in the Advanced Configuration window of Layout
Designer, select the External Devices tab.

1. Under Type, choose Image Video Tally.

2. Under Port, choose the COM Port that TSL communication will be
received through.

3. Under COM settings, choose communication settings to match the settings
on the Image Video unit.

For RDU-1000 serial format, those settings should be:
e Baud rate: 9600 bits/second

» Data bits: 7
e Parity: Even
e Stop bits: 2

For RDU-1510 serial format:
» Baud rate: programmable to 300, 600, 1200, 2400, 4800, 9600, 19200,

or 38400 baud
« Data bits: 7
» Parity: Even
» Stop bits: 2
4. Click Add.

To create labels:
Syntax: %(Addr) D%1S(strings) %Z
#D: 1~255 (UMD Address)
String: <display string up to 17 characters>
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5. %Z: Terminator

Table C-1. Color Block Coding

First Second Third Fourth Fifth
Text color Set tally 0 Set tally 1 Set tally 2 Set tally 3
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Overview

To change the mode of Serial Ports 1-4, you need to enter the BIOS. You need
a keyboard attached to the multiviewer module to enter the BIOS and make
these changes.

Topics described include:

e “Entering the BIOS” on page 94

* *“Changing the Serial Port Operation Mode” on page 95

e *“Changing Serial Port Termination” on page 95

» “Saving your Changes and Exiting the BIOS” on page 96

-5
# Note
Do not change any other settings in the BIOS.

Harris Multiviewer Installation, Configuration, and Operation Manual 93
Copyright © 2008-2009, Harris Corporation



Appendix D: Configuring Serial Ports

Entering the BIOS

To configure the mode of serial port 1 or 2:

1. Power cycle your Layout Designer module, or select Restart System from
the Multiviewer Control Panel. (See “Restarting the Multiviewer Control
Panel” on page 54.)

2. Assoon as the motherboard starts, press the CTRL+SHIFT+B keys (for the
original release BIOS) or B (for the new/current BIOS) on the keyboard.

The BIOS menu opens.

RIOS SETUP UTTLITY

Figure D-1. BIOS Menu

3. Press the right-arrow key on your keyboard to open the Advanced menu.

RIOS SETUP UTTLITY

b LA Configuration

Figure D-2. Advanced Menu
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4. Press the down-arrow key on your keyboard to scroll down to the SuperlO
Configuration menu, and then press the Enter key.

RIOS SETUP UTTLITY

Serlal Portl Address [3F0/TROA]

Figure D-3. SuperlO Configuration Menu

Within the SuperlO Configuration section of the BIOS, you can change the
mode of the serial port, and the termination type.

Do not change any other settings in the BIOS.

Changing the Serial Port Operation Mode

Within the SuperlO Configuration section of the BIOS, follow these steps to
change the mode of serial ports 1 and 2:

1. Scroll down to COML1 Port Mode Select.

2. Press the Enter key to open the Options screen to change between RS232
and RS422/485 (default).

3. Scroll down to COM2 Port Mode Select.

4. Press the Enter key to open the Options screen to change between RS232
and RS422/485 (default).

The default for both Serial Ports 1 and 2 is RS422/485.

ﬁ“ Note

Serial Ports 3 and 4 are fixed RS-232 ports.

Changing Serial Port Termination

Within the SuperlO Configuration section of the BIOS, follow these steps to
change the termination setting of serial ports 1 and 2:

1. Scroll down to the COM1 RS422/485 120 OHM Termina.
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2.

Press the Enter key to open the Options screen to change between No
Termination and With 120 OHM Termination (default).

Scroll down to the COM2 RS422/485 120 OHM Termina.

Press the Enter key to open the Options screen to change between No
Termination and With 120 OHM Termination (default).

The default for both Serial Ports 1 and 2 is With 120 OHM Termination
(termination enabled).

Saving your Changes and Exiting the BIOS

After making your changes to Serial Port Operation Mode and Termination, you
may want to save your changes.

To exit the BIOS, do one of the following:

To save your changes and exit the BIOS, press the F10 key.
The following message appears:
Save configuration changes and exit setup?

With the arrow keys, select Ok to continue or Cancel to go back to the
BIOS settings screen.

To exit the BIOS without saving your changes, press the ESC key.
The following message appears:
Discard changes and exit setup?

With the arrow keys, select Ok to continue or Cancel to go back to the
BIOS settings screen.

Once you exit the BIOS, the multiviewer restarts with the new BIOS settings.

-

~¥
“ Note

All BIOS configuration changes will be lost when the battery replacement
procedure as outlined in “Servicing Instructions” on page 83 is performed.
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setting 31
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Lock Display parameter 39
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connecting 70
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